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Welcome to CAMIO 
Purpose of This Manual 
This manual provides a comprehensive resource for CAMIO system administrators. It covers 
CAMIO 5, and covers the functions available in the Admin Tools user interface, which are used 
to set up a CAMIO system, MOS Newsroom Interface, playout devices, users and user 
preference. This manual does not cover extended functions of CAMIO Cluster and DR systems 
which are covered in other documents. This manual does not cover the creation, upload, and 
management of CAMIO assets using the Asset Manager user interface. 

Customer Support 
If you have questions, please contact Chyron customer support in your region. 

●​ Americas and Asia, call +1 631 845 2132. 

●​ In Europe and Africa, call +44 208 996 9933.  

Visit the Chyron Website at www.chyron.com, for immediate access to our user forums, 
knowledge base and an array of documentation, downloads and other information to assist 
you. 
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Some Useful Definitions 
●​ Contexts are groups of assets available (Templates, Images, etc.) for use in CAMIO. 

Contexts are most commonly used to manage content that shares a common look. For 
example, you can create two Contexts to distinguish between morning news and evening 
news graphics, each with their own look. Contexts can also be used to manage users. If 
your facility employs graphics to which only specific users should have access, then this 
type of asset might be located in a separate Context, since user privileges include a choice 
of accessible Contexts. 

●​ Templates and Scenes, for use in a CAMIO environment, can be created on multiple 
different Chyron templating platforms. Templates can be graphics, clips, or automation 
cues, and are defined as the shells that are married with Replaceable items in LUCI that 
are fulfilled by a producer or reporter. Templates must have appropriate XML data 
associated with them. Each rendering device, upon creation of the CAMIO template, 
automatically creates this XML, which then must be uploaded into CAMIO, through a 
variety of methods, to be available to producers. The PRIME system refers to Templates as 
Scenes. 

●​ Images, for use in CAMIO’s MOS System, must be of image formats compatible with the 
rendering device with which they are used (e.g., BMP, JPG, PNG, TGA, TIF, etc.). These 
images can be created using a wide variety of applications and uploaded to Asset 
Manager from a PC or Mac. 

●​ Movies, for use in CAMIO’s MOS System, must be in a compatible movie format for the 
device that is rendering it. These movies can be uploaded to Asset Manager from a PC or 
Mac. 

●​ Asset Manager is a simple-to-use HTML5-based application for managing CAMIO content 
through a lightweight web browser client. 

●​ LUCI is the graphic interface used by the newsroom to browse the CAMIO content and 
create MOS Objects. From LUCI, the newsroom user can load, edit and preview a 
template, and then insert it into a script. 

●​ Virtual Channels are defined in CAMIO. Template assets are then assigned appropriate 
channels for output. In the Context Admin Tools, there is a Virtual Channel-to-Physical 
Channel mapping that is used to determine the exact physical output channel for each of 
these virtual channels. 
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●​ Layers are a PRIME feature that enables the PRIME system to independently render 
multiple scenes to one output. Higher-numbered layers are displayed over lower-numbered 
layers. 
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How CAMIO Works 
CAMIO is a centralized asset server that manages content for playback using Chyron 
equipment. It provides the following functions: 

●​ Assets are uploaded from the Art Department to the CAMIO Server using either the 
rendering device, Asset Manager or Ingest folders. 

●​ Once uploaded, the newsroom staff (producers) can browse these assets and select 
templates within a simple interface called LUCI. The producer can select a template, and 
can then edit any text, images or movie Replaceable fields in the Template and insert it into 
their MOS rundown. 

●​ The MOS Newsroom system publishes a rundown to CAMIO, specifying which MOS 
Objects are required for playout. CAMIO sends these required assets to the playout 
machines, along with a rundown in XML format. When a rundown is deactivated by the 
newsroom system, then CAMIO removes the objects that are no longer needed from the 
playout machines. 
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Admin Tools Utility 
The Admin Tools utility is used to configure and manage the CAMIO system. 

●​ Access to Admin Tools should be restricted to the trained CAMIO system 
administrators only. 

●​ It is advised that the default login be changed and/or replaced by specific 
administrator logins. 

Opening and logging in to the Admin Tools Utility 
Chrome is the preferred browser for administering CAMIO. To open the CAMIO Admin Tool 
Utility: 

1.​ Do one of the following. 

1.​ From any system connected to the CAMIO Server network: 

a.​  Open an internet browser (preferably Chrome), and then enter: 
http://<CAMIO_SERVER>/CAMIO 

The CAMIO Central home page displays. 

b.​ Click the CAMIO Admin Tool Utility button. 

 

2.​ Or, go directly to the Admin Tool Utility by entering:​
http://<CAMIO_SERVER>/CAMIO/Management 
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The CAMIO Admin Tool login window is displayed. The CAMIO version number 
appears below the sign-on boxes in a dark blue color. 

 

2.​ Upon initial entry, a login prompt displays. Default login is:​
Username = admin, Password = admin 

You can change the Username and Password after logging in to the system. 

Click the Sign In button to open the Admin Tools UI.  

All CAMIO Admin functions are accessed from the menu items along the left side of the 
screen. 
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Admin Tools Menu Items 
The following comprise the CAMIO Admin Tools: 

●​ Documentation 
○​ Manuals and Installers 

●​ Reporting 
○​ List Assets 
○​ List Running Order 

●​ Administration 
○​ Device 
○​ Context 
○​ Group 
○​ Context Permission 
○​ Ingest Folders 
○​ User 
○​ LUCI Autofill 
○​ License 
○​ Asset Categories 
○​ Metadata Mapping 
○​ Media Engine Formats 
○​ Media Engine Presets 
○​ Replication 

■​ CAMIO Server Management 
■​ Replication Management  

○​ PRIME Styles 
○​ MOS Reskinning 

●​ Configuration 
○​ CAMIO Configuration 
○​ LUCI Configuration 
○​ MOS Configuration 
○​ Playlist Configuration 
○​ FileSync Configuration 
○​ Media Engine Configuration 
○​ LUCI User Defaults Configuration 
○​ Job Schedule Configuration 
○​ AXIS Configuration 
○​ Automation Transition Configuration 
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Documentation 
The Documentation section displays manuals and installers relevant to either the operation or 
installation of CAMIO. These are updated periodically with new CAMIO releases. 

Manuals and Installers 

●​ Installers can be found at: https://da.chyron.com (ask your Chyron representative for 
credentials) 

●​ Contact Chyron Support for the proper version of LUCI container to use your newsroom 
system. 

Reporting 
The Reporting section displays status information about the CAMIO server, including a display 
of available assets, and active Running Orders currently on CAMIO. 

List Assets 

Selecting List Assets exposes the options shown below. 

The drop-down menu at the left 
specifies which context is to be 
returned. The drop-down menu in 
the middle specifies the type of 
asset type to be returned (images, 
videos, etc.). The drop-down 
menu at the right specifies the 
type of asset is to be returned 
(assets, deficient assets or fulfilled 
assets). 

Once the parameters are set, selecting Display Assets shows all assets that follow the 
parameters set by the drop-down boxes. Each asset displays a thumbnail of the asset, and the 
asset’s Title, Description and Asset Type. Selecting Download downloads a copy of the 
asset to the local system. The downloaded file contains  

●​ Thumbnail 
●​ Filename  
●​ Title 
●​ Description 
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●​ Asset type 

 

 for each asset. Files are downloaded in htm format. 

Selecting Preview previews the asset on a new tab. 

This user interface is meant for quick checks only. The Asset Manager UI is a better tool for 
browsing and editing assets.  
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List Running Order 

This view shows all active Running Orders being sent to CAMIO by the Newsroom Computer 
System via MOS Protocol. If there are no currently active Running Orders, then the view 
displays the following: 

 

If there are one or more active Running Orders being sent to CAMIO, then you can select a 
Running Order from the drop-down box. 

The label Active applies only to ENPS, for which a Running Order can be published to 
CAMIO, but is not active. 

A rundown that is not active is not sent to the CAMIO Rundown Endpoint and Viewer (formerly 
iSQ) for playout. 
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The Running Order shows the rundown broken down into stories, and each story shows the 
MOS Object’s thumbnail and some metadata. 
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Administration 
The Administration and Configuration sections are used to set up the various components of 
the CAMIO system. 

Device 
The CAMIO Device Management table displays current playout devices in use with the 
CAMIO system and the number of licensed channels. The total number of channels assigned 
cannot exceed the number of licensed channels.  

Note that FolderWatcher channels do not count towards the total of licensed channels.  
Circled in red below. These are special playout channels that are used by the Media Engine’s 
Folder Watcher feature.  Folder Watcher setup information is available in this document CAMIO 
Folder Watcher User Guide 

 

Each Playout device is added to a row with the following information.  

●​ Name: The name specified for the device. The device Name is how the machine is 
referenced in the Context menu Channel Assignment fields. 

●​ Type: Specifies the type of device that is used with the CAMIO system: 
○​ GS2/CRD 
○​ Folder Watcher 
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○​ Lyric 
○​ PowerClips 

●​ Playout Host Name: Specifies the hostname or IP address of the device. 

●​ Playout Folder: The local network share of the playout folder that is used to copy over 
rundown content. 

●​ Physical Channels: Specifies the number of physical channels available to the device 
and their names. 

●​ Enabled: Specifies either True or False to determine whether or not the device is 
currently active. It is important to disable any device that is not active, as not doing so 
may slow down CAMIO asset distribution and takes up a licensed channel. 

●​ Device Status – Specifies the status of live devices: 

○​ A green circle signifies that the device is ready for use. 

○​ A red circle signifies that access to the device is denied. 

○​ A yellow circle signifies TBD. 

○​ A grey circle signifies that the device is not enabled. 

●​ Delete: Select the corresponding Delete icon  to delete the device. Devices cannot 
be deleted if they are being mapped in the Context menu. You must first delete all 
references to a device in Context mapping before you can delete the device. 
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To create a new device: 

1.​ Click Create New Device. The following window displays. 

 

2.​ Set the following specifications for the new device: 

○​ Name: Enter a user-friendly display name to easily identify the device. 

○​ Type: From the drop-down box, select the type of playout device. (e.g., 
GS2/CRD, Lyric, Media Maker or PowerClips) to create. 

○​ Modes: Defines the method with which assets are sent to the playout device. 
Defaults to Default. Other Modes are used only in very specific circumstances, 
and should not be selected without direction from Chyron Support.  

○​ Playout Host Name: Input the Host Name or IP Address of the playout device. 
In general, using IP addresses improves system performance by eliminating 
possible DNS lookup delays. IP addresses can be used only if all playout 
devices are configured for fixed IP addresses and are not using DHCP.  

○​ Playout Folder: Input the local network share of the playout folder, used by 
CAMIO to copy over Running Order content. Recommend using CAMIO4 as 
the playout folder share name. 
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○​ Playout Share Local Path: The local path of the playout folder on the playout 
device, which is required by PRIME and Lyric to locate and play out 
non-embedded assets. Recommend using I:/CAMIO4 as the playout path. 

○​ Socket Port: Enter the port number to be used to send the MOS Running 
Order to the playout device’s CAMIO Rundown Endpoint and Viewer service. 
Defaults to 10542. This is changed only in special circumstances, as directed by 
Chyron Support. 

○​ Enabled: Check/uncheck this checkbox to enable/disable the device upon 
creation. NOTE: It is extremely important that any playout devices that are not 
actively running playout software are disabled. A significant delay is introduced 
when CAMIO attempts to communicate with a playout device that is not active. 

○​ Physical Channels: A table showing the name and number of physical channels 
is displayed. 

■​ To add another physical channel, use the text box below to input the 
desired name for the physical channel that is to be created, and then 
click the Add button. 

■​ To remove a physical channel, click the corresponding Delete icon . 

Note that when selecting Type = Folder Watcher the Playout Hostname will be automatically set 
to Localhost and the Mode will be set to Master Share. 
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Context 
One of the functions of CAMIO is as an Asset Management system. It stores graphics 
templates, images and videos, along with descriptive metadata that makes these easier to find. 
Assets in CAMIO are stored in groups called ‘contexts’. A context is usually a group of assets 
that is used on a show or group of shows, but it can be used in many other ways. Contexts are 
created to organize these templates and assign specific playback hardware channels using the 
AdminTool Contexts menu. 

Contexts are available from the drop-down menu in the templates and images tabs of LUCI. 
Contexts are generally created to separate distinct styles (i.e., morning news and evening news 
looks), but can also be used to group content available to specific individuals such as weather 
and sport Contexts. 

Selecting Contexts displays the following: 

 

 

The table displays a list of the existing contexts and information about them: 

●​ Name – How the context is referred to in the CAMIO system. 
●​ MOS Output Type - The only option available is LyricDataMessage. 
●​ Asset Path - The hard drive location of the context. This is typically 

i:\camio4\contextname and should not be changed.  
●​ Current MOS ID – Every time a new MOS Object is generated, it is automatically 

assigned the value of the Current MOS ID + 1. This is automatically reflected in the 
Current MOS ID field. 

●​ Description – Any user-entered notes/description about the context. 
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●​ Delete – Click the corresponding red X to delete the context. A context cannot be 
deleted if it has any active MOS objects, which will be true in many cases. 

In order to create a new context, select the Create New Context option. The following window 
displays: 

 

You then may specify information pertaining to the context that is to be created. 

●​ Name - Enter a name for the new context. The context name is used as a “Directory 
Namespace.” The context name must begin with a letter and may include underscore 
characters and a single dash, but no spaces. You cannot change the context name after 
the context is saved. 
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●​ Current MOS ID – The value of the Current MOS ID is automatically initialized to 10000, 
but can be changed to start at an arbitrary value. Before changing this value, note that 
when the completed messages are sent to the output device, they are sent to a folder, 
with the same name as the context, in the path set up using the Device Manager. Since 
the created message and template message are sent to the same folder, it is 
recommended that the current message number be set to a value higher than any of the 
template message numbers; so that they are not overwritten by created MOS object 
messages. The Current MOS ID is specified only on initial setup of a context. Once the 
initial setup is submitted, then you can no longer change this number. This is done to 
prevent the unintended overwrite of existing MOS objects. 

●​ Description – Any information may be entered into this field to serve as notes or 
information pertaining to the context. 

●​ Create Default Folders - selecting this option will automatically create the following 
folders in the Context: 

○​ Scenes 
○​ Images 
○​ Clips 

 

●​ Channel Assignments – Each content must have channel assignments that map virtual 
channels (selected in LUCI) to physical channels on playout devices. Before any 
settings can be entered, playout devices must first be configured in the Device settings 
of the Admin Tools. Once the playout device is configured: 

○​ Select the virtual channel. 

○​ Select a configured playout device. 

○​ Select the physical output channel. One virtual channel can be mapped to 
multiple output devices, but to only one channel per device.  

●​ Copy From Context - Channel assignments can be copied from an existing context to 
speed up context creation and reduce errors. 
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Groups 
One of the features of CAMIO is the ability to manage user permissions from a central location 
using the Admin Tool. The fundamental concept of user management in CAMIO is that users 
are assigned to Groups which are then given access to Contexts. The Admin Tools Group 
menu enables you to create, update and delete Groups. 

 

The table displays the following information about the existing groups: 

●​ Name – The name given to the Group. 

●​ Description – A description about the Group as previously entered by the user. 

●​ Type – Defaults to System. There are no other types used at this time. 

In order to create a new group, click the Create New Group button. The following window 
displays: 

 

Specify the following information pertaining to the Group that is to be created. 

●​ Name – Specifies the name of the Group. 

●​ Description – Descriptive information or notes about the Group. 

●​ Users Assigned – You have to add at least one user to the Group. From the drop-down 
box, click the Add button to add the user to the Group. 
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All Users Group - All users automatically become part of the All Users group and cannot be 
removed from the group. 

Context Permission Management  
Different Groups may be given access to different Contexts. The Context Permission 
Management page is where you specify Context Permission. 

 

The Name column displays a list of all of the Contexts on the CAMIO system. The 
corresponding Groups Permissioned column lists the Groups that are allowed access to the 
Context. 

To edit which Groups are permissioned to a context: 

●​ Click the name of the Context for which you would like to change permissions. The 
following window displays: 

 

The Context window displays the following information: 

●​ Name of the Context 

●​ A list of the names of the Groups that are currently allowed to access the Context. 
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To add a Group: 

1.​ From the drop-down menu, select the Group to which you would like to grant access. 

2.​ Once the Group is specified, click Add, and then Save, to ensure that the Group is 
added.  

All Users Group - All users automatically become part of the All Users group and cannot be 
removed from it. If limiting access to a context is not a concern, then it is convenient to assign 
the ‘All User’ group to that context. 

Ingest Folders 
CAMIO offers a quick ingest method to upload objects directly into Asset Manager specified 
Context both locally and remotely when they are placed into a folder configured to ingest 
objects. CAMIO continuously monitors these folders and ingest objects placed into them, and 
deliver them to the CAMIO Context that is mapped to the ingest folder. 

 

The Ingest Folder Management window displays previously created Ingest Folders and their 
parameters: 

●​ Name – The name of the Ingest Folder. 

●​ Description – Some descriptive words about the Ingest Folder. 

●​ Path to Monitor – The system location of the Ingest Folder. 

●​ File Pattern – The File pattern of the Ingest Folder, i.e., the file mask that determines 
which files to process. For example, *.jpg specifies that the Ingest folder will process 
only jpg files. Note that *.* specifies that the Ingest folder will process all files. 

●​ Context – The Context to which the objects that are ingested are delivered. 
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●​ Serialization – Whether or not the file names will have automatically created unique 
tags. 

●​ Use Sidecar XML – Whether or not the ingested files have metadata sidecars.  
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To create a new Ingest Folder: 

1.​ Click the Create New Ingest Folder button. The following window displays: 

 

2.​ Specify the following pertaining to the new Ingest folder: 

●​ Name – The name of the folder that CAMIO is to monitor. 
●​ Description – Descriptive information about the folder. 
●​ Path to Monitor – The path to the folder that is to be monitored. 
●​ File Pattern – Enter a file pattern in the format <file name>.<extension>. File 

Pattern specifies the file mask that determines which files to process. For 
example, *.jpg specifies that the Ingest folder will process only jpg files, i.e., 
c:\CAMIO\Ingest_Folder_Images\*.jpg will process only jpg files. Note that *.* 
specifies that the Ingest folder will process all files. 

●​ Context – From the drop-down box, specify the Context to which the objects 
are to be delivered. 

●​ Context Folder Path – From the drop-down box, specify to which folder in the 
Context the objects are to be delivered. 

●​ Metadata Mapping – Select a metadata mapping rule that will be applied to 
assets ingested by this folder. 

●​ Serialize File Names – Enabling this option will create unique tags for the file 
names in order to avoid inadvertent overwriting. NOTE: When enabled, you are 
prohibited from performing Upload Replace via the ingest folder, as a file name 
match will never be made. 

●​ Sidecar XML – When enabled, the ingested files hold metadata sidecars. NOTE: 
The name of the sidecar file must be the same as the file being ingested with the 
extension of XML. ALSO NOTE: When enabled, no image will be ingested unless 
it has a corresponding sidecar XML file. Likewise, no XML file will be ingested 
without a corresponding image file. 
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BEST PRACTICE: It is recommended to place the ingest folder in the I: drive of the CAMIO 
server if possible. Avoid using mapped drives and network shares as they can be slow and 
unreliable. If a remote machine is sending assets to CAMIO via an ingest folder, then it is 
preferred to share the i:\ folder to the remote process rather than sharing a remote folder to 
CAMIO. 

AXIS Fulfillment Folders - Ingest Folders in CAMIO 4.x replace both the Fulfillment Folder and 
Hot Sync folders of CAMIO 3.x. If the incoming asset is a ‘deficient asset’ which was ordered 
through LUCI (i.e., from AXIS News, Maps or Order) then the asset will be delivered to the root 
of the context belonging to the LUCI template that ordered it. If the incoming asset is not a 
deficient asset, then it will be ingested into the context folder defined above in the Context and 
Context Folder Path settings. This context is typically named ‘Orphans’, to highlight that these 
assets were delivered incorrectly.  

 

User Administration 
User administration specifies user access to the CAMIO server. You can create, update and 
delete users, add or remove users from Groups, and grant users access to specified Contexts. 
Special users can be granted administrative and/or asset management roles. LUCI 
configuration settings are defined here. 

There are two main classes of users: CAMIO Users and LUCI Users. 

LUCI Users - These are reporters, producers and other users that use LUCI and the newsroom 
system to create and edit MOS Objects and rundowns. 

●​ LUCI users do not require a password. 
●​ The LUCI username is usually provided to LUCI by the newsroom system login. 
●​ A LUCI user is automatically created whenever someone logs into LUCI with a new 

username. 
●​ By default, all LUCI users are in the All User group, and can be assigned to special 

groups in order to control access to certain contexts. 

CAMIO Users - This category involves Administrators and Artists. 

●​ Administrators can log in to the Admin Tools UI and have complete control of all 
CAMIO configuration. Administrators are CAMIO users that have been assigned to the 
Admin group. There is a default administrator login: admin password: admin that ships 
with every CAMIO. It is possible to change the admin password, and to create new 
admin users. 

○​ In order to create a new CAMIO Admin User: 
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■​ Select “CAMIO User” in the “Type” drop-down box. 
■​ Enter and verify a user password.  
■​ Select “Admins” from the Member of Group drop-down, add it to the 

user and click “Save.” 
●​ Artists can log into Asset Manager and create assets, metadata, folder structure and 

replication in a multi-CAMIO network environment. Admins also have Artist privilege. 
○​ In order to create a new CAMIO Artist User: 

■​ Select “CAMIO User” in the “Type” drop-down box. 
■​ Enter and verify a user password. 
■​ Select “Artist” from the Member of Group drop-down, add it to the user 

and click “Save.” 

A note about passwords - Passwords are entered by an admin user and there is no 
mechanism in CAMIO to recover lost passwords. Lost passwords can be changed only by an 
admin user. If the password is lost for the only admin user, then please contact Chyron Support 
for help to reset the admin user password. 

A note about HubDrive user permissions - CAMIO administrators automatically get 
Administrator privilege in the HubDrive system. CAMIO Artists automatically get Artist privilege 
in HubDrive. All other CAMIO users have read-only privilege in HubDrive. See the Hub Drive 
CAMIO Setup Manual for more information. 

 

The User Management window displays previously created Users and their parameters: 

●​ Name – The unique name given to the User. 
●​ Description – A description about the User. 
●​ User Type – Specifies whether the user will access LUCI (as a Producer) or CAMIO (as 

an Administrator or Artist). 
●​ Change Password – If a password is enabled, then clicking Change Password will 

allow a CAMIO user to create a new password. LUCI Users do not have a password. 
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To edit an existing User, double-click the name of the User. 

To delete a User, simply click the red X. NOTE: You can delete an Admin User only if you are 
logged on the Admin Tool with an Admin User other than the one that you would like to delete. 

To create a new User: 

1.​ Select the Create New User button. The following window is displays: 

 

 

30 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      



 

2.​ Specify the following information pertaining to the new User. 
●​ Name – Input a unique name to assign to the User. 
●​ Type – From the Type drop-down box, specify whether the User will be a CAMIO 

User or a LUCI user. 
●​ Description – Input descriptive words or information about the User. 
●​ Group Membership Management – Use the drop-down box to add the User to 

desired Groups. 

LUCI Configuration Settings Overview - There are two sets of configuration settings: one for 
legacy ActiveX LUCI, and one for the new HTML5 LUCI. There are more features in HTML5 
LUCI. In each case, it is possible to show the tab, hide the feature or default to the LUCI User 
Default Configuration setting, which is described below. Note that all of these features can be 
enabled and disabled for individual users. 

●​ Graphics Templates – Shows or hides the Graphics Templates browser. 
●​ Completed Graphics – Shows or hides the Completed Graphics browser. 
●​ Automation Templates – Shows or hides the Automation Templates browser. 
●​ Studio Clips – Shows or hides the Clip Asset browser. 
●​ Running Orders - Displays or hides the Running Order browser. 
●​ AXIS Track in Asset Browser– Displays or hides the AXIS Track asset browser 

(requires that AXIS Interface is configured and that the user has an AXIS login). 
●​ Compose Images – Shows or hides Image Compositor feature.  
●​ Compose Movies - Shows or hides the LUCI Clipper feature. 
●​ Order - Displays or Hides the AXIS Order window (requires that AXIS Interface is 

configured and that the user has an AXIS Order login). 
●​ Time Code – Displays or hides the Time Code tool in the lower right corner for 

adjusting graphics in and out points in supported newsroom automation systems or for 
display in the CAMIO Rundown Endpoint and Viewer. 

●​ Slug - Displays or hides the slug text entry tool. 
●​ Channel - Displays or hides the channel assignment tool. 
●​ Delivery Feed - Displays or hides the AXIS delivery feed status. 
●​ Enable Auto Preview - Enables or disables the Auto-Preview feature in LUCI. 
●​ Publishing - This feature is not available as of CAMIO 4.6. 
●​ Saved Items - Enables or disables the LUCI Saved Items feature from being displayed. 

This hides both the Saved Items tab and the Save Items button on the action toolbar. 

 

31 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      



 

 
Group Membership Management 
Users can be added to groups for the purpose of controlling access to certain content. 

●​ Admin group is reserved for administrators and requires a user of Type = CAMIO User 
which has a password. Admin group users have access to CAMIO Admin Tools and 
Asset Manager UIs. 

●​ Artists group is reserved for the art department and requires a user of Type = CAMIO 
User which has a password. Artist group users have access to the CAMIO Asset 
Manager UI. 
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LUCI Auto Fill 
LUCI AutoFill enables quick update of template content with predetermined text and images. 
Data is formatted in a text file format and uploaded to the LUCI AutoFill Web Interface. See 
Appendix A for more information. 

 

●​ Upload New Data File – Allows the user to upload a new data file in the form of a text 
file format. 

●​ Download Data File – Allows the user to download an already uploaded data file. 
●​ Replicate to other CAMIOs - Select whether this Autofill Group should be replicated to 

other CAMIOs configured in the Replication Management section. 
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License 
CAMIO employs a hardware license dongle that enables the operation of CAMIO and optional 
features. The License tab displays the CAMIO License Management window. 

 

The CAMIO License Management window displays the following license settings: 

●​ Type: The type of licensing that is used for the current CAMIO system. 
●​ Major Version: Major version of CAMIO that can be run under this license. 
●​ Expiration: The expiration date of the current license. 
●​ License Status: Displays whether or not the current license is enabled or disabled. 
●​ Cluster: Enables running CAMIO in a cluster configuration. 
●​ DR: Enables running CAMIO in a DR configuration. 
●​ MOS Redirection: Enables the MOS Redirection feature. 
●​ MOS Object Reskinning: Enables MOS Reskinning and PRIME Styles Reskinning 

feature. 
●​ Replication: Enables the Replication feature. 
●​ Media Engine: Enables the Media Engine feature. 
●​ Social Media Publishing: This feature is not currently supported. 
●​ Playout Channels: Licenses the maximum number of playout changes that can be 
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enabled. 
●​ LUCI Concurrent Seats: Licenses the maximum number of concurrent LUCI users. 

Asset Categories 
The Asset Category Management section allows you to create or modify different 
classifications under which assets are to be filed. This makes it easier to search or filter for 
assets depending on the application. Asset Types are used in Asset Manager and LUCI 
(HTML5 version). 

Separate Asset Categories exist for Templates, Images and Videos.  

 

Asset Categories are listed in the order in which they are displayed in the Asset Manager and 
LUCI UIs. 
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To change display order: 

●​ Click the Up and Down Arrows. 

To delete an Asset Category: 

●​ Click the corresponding red “X” button. 

Asset Categories cannot be deleted once they have been assigned to an asset. 

To create a new Asset Category: 

1.​ Click the Add New Asset Category Button. The following window is displayed. 

 

2.​ Enter the name of the new Asset Category in the text field, and then click the Save 
button to create the new Asset Type. The new Asset Category displays in the Asset 
Category Management table. 
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Metadata Mapping Management 
 
Metadata Mapping refers to rules for automatically creating CAMIO asset metadata when an 
asset is ingested. The CAMIO asset metadata is as follows: Title, Author, Description, 
Keywords, Subject, and Category. Metadata Mapping rules are assigned to ingest folders so 
that the metadata can be automatically generated when the asset is ingested. 

 
 

Create New - Title, Author, Description, Keywords, Subject metadata can be created using the 
following rules. 

●​ File Attribute - File properties such as filename, extension, datestamp.  
●​ Plain Text - Any free form text value. 
●​ Sidecar XML - Metadata is extracted from information in the sidecar XML ingested with 

the asset. Sidecar XML is primarily used when assets are delivered by AXIS.  
●​ XMP Metadata - In the case of images, metadata can be extracted from XMP 

embedded in the file. A reference XMP file is needed to predefine what XMP data is 
expected.  

 
XMP Upload - Upload dialog for uploading the XMP reference Image. 
 

 

37 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      



 

XMP Reference Image - Displays filename of the XMP reference image once it has been 
uploaded.  
 
 

Categories - Category metadata is unique in that it has to use category values that already 
exist in CAMIO. A given Metadata Mapping Rule assigns one or more values of Category based 
on the Asset type using a multi-select drop-down  

 

 

Media Engine Formats 

 

This user interface allows copies, edits and deletes of movie and image file formats. Note that 
some formats are not editable or deletable, as you can tell by the greyed out delete icon.
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 Click the copy icon to copy an existing format, edit it and save it as new. 

 Click the delete icon to delete an existing format. 

 Click the Default radio button to select the default Media Engine Format. 



 

Media Engine Presets 

 
 

- Click the Create Media Engine Preset button to open 
the dialog to create a new destination from scratch. 

 

 - Click the copy icon to copy an existing destination, edit it and save as new. 

- Click the delete icon to delete an existing destination. 

- Click the Default radio button to select the default destination. 
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Replication 
Replication is a powerful tool for distributing assets between multiple CAMIO Servers in a 
station group. Replication copies assets from one folder (or subfolders) on one CAMIO to a 
folder or subfolders on another CAMIO. This tool is often used in a station group to distribute 
assets from a hub art department out to other stations on the network.  

Replication – CAMIO Server Management 
The CAMIO Server Management tab allows the user to specify which CAMIO Servers are to be 
used in replication and test the connection to them. 

 

In order to add a new CAMIO Server, click the Add CAMIO Server button. The following 
window is displayed. 

 

●​ Display Name – Enter a name that will be used to refer to the server. 
●​ Host Name – Enter the hostname or IP of the host that is to be connected to. 
●​ Username & Password – Enter an administrative username and password that can be 

used to access the remote CAMIO server. 

After inputting all the required information, click the Test Connection button to test the 
connection to the remote server. Once the connection is verified, click the OK button to add the 
new CAMIO Server.  

In order to edit existing CAMIO servers, click the display name of the server located on the 
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CAMIO Server management page. 

Replication Management 

The Replication Management tab allows users to create replications between CAMIO Servers 
in a station group network. There are two types of replication; Asset Replication and LUCI 
Autofill Replication 

Asset Replication - copies all assets and their metadata from the Source CAMIO/Context/Path 
to the Destination CAMIO/Context/Path. Any change in the Source will be sent to the 
Destination. Replication never deletes assets from the destination folder, but may overwrite 
them with a new copy 

LUCI Autofill Replication - copies LUCI Autofill table from the Source CAMIO to the 
Destination CAMIO. Individual autofill groups can have replication enabled and disabled, as 
shown in the LUCI Autofill section. 

 

 

Replication is configured using the CAMIO Admin Tools, not the Asset Manager. The 
destination CAMIO gets a list of assets to download from port 80 on the source CAMIO. On the 

 

42 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      



 

Replication Management tab, a table is displayed that shows all previously created replications 
and their parameters. 

Details button shows the status of replication processes with a list of files in the queue. 

Resync button will replicate all content in the source folder to the destination folder 
“re-syncing” them. 

Sorting the lists of replications and LUCI autofills can be done by clicking on the column 
headings - once to sort A-Z and again to sort Z-A. 

Re-sync All button will resync all replications across all CAMIOs in the group. This can be 
done for either Replications or LUCI Autofills. 

 

Replications cannot be edited. In order to change a replication, it must be deleted and a new 
one created. The Replication Management page shows replications for which this CAMIO is a 
source and for which it is a destination. Note that replications can only be re-synced and 
deleted from the source CAMIO. 

In order to create a new Asset Replication, click the Create New Replication button. The 
following window is displayed. 

 

●​ Source Context – Specify the context from which the files are to be replicated. 
●​ Source Path – Specify the path in the context from which the files are to be replicated. 
●​ Destination CAMIO – Select which CAMIO Server the replicated files are to be 

delivered to. 
●​ Destination Context – Select the new context that the replicated files are to be 

delivered to. 

 

43 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      



 

●​ Destination Path – Select the path of the context in which the files are to be delivered 
to. 

●​ Sync Deletions - When the Sync Deletions option is set to true in the Replication 
Management page, then deletions made on the Hub CAMIO are also be made on the 
spoke CAMIOs. 
 

In order to create a new LUCI Autofill Replication, all that is needed is the name of the 
destination CAMIO.  
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PRIME Styles 
CAMIO 4.9 onwards support PRIME Styles functionality. Requires compatible PRIME software 
and content employing the Styles feature.  

This section defines a list of PRIME Styles per context which will be displayed in LUCI 
drop-down and embedded in the MOS Object for preview and playback. Style value assigned 
to a PRIME MOS Object can be displayed in mosAbstract and ISQ Viewer playlist using %y. 

 

Add Context Styles - select from a list of contexts in the drop-down to add Styles. 
●​ Styles can be deleted by clicking the red X. Deleting a style from a context will not affect 

MOS objects previously created. copied from another context.  
●​ Styles will be displayed in LUCI in the order they are placed in the list. Drag/drop the 

styles to rearrange the order.  
●​ Copy from Context - Styles can be copied from an existing context to speed up 

context creation and reduce errors. Only contexts which have styles defined will be 
shown in the drop-down. 

 

Edit existing context styles - click the context name to open the edit dialog to make any 
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changes to the context styles.  

MOS Reskinning Management 

 

CAMIO MOS Reskinning provides the ability 
to copy already prepared MOS objects from 
one Running Order, drop them into another 
Running Order and have the ‘look’ of the 
MOS objects automatically take on a 
different look, while retaining the replaceable 
data. 

 

There are two types of reskinning processes available; Context Reskinning and Style 
Reskinning that work differently but give similar results. Context Reskinning works with Lyric 
and PRIME templates. Style based reskinning works with PRIME graphics only. The theory and 
operation of Context and Style Reskinning is described in a different document. 

The CAMIO Administrator must define the reskinning rules as follows. 
●​ Reskinning rules are assigned to a MOS rundown. 
●​ A rundown must be MOS active for CAMIO to see the MOS Objects and replace them 
●​ CAMIO will detect which items need to be reskinned and attempt to reskin them 
●​ If possible, a new MOS Object will be created and a mosItemReplace message will be 

sent to the newsroom system to replace the original item with the reskinned item.  
●​ It is possible to create both Context and Style Reskinning rules but not in the same 

Running Order.  
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Context Reskinning 

 

Context Reskinning requires that you have at least two contexts with matching templates, ie., 
they have the same filename and same names for replaceable text, image and movie fields. 

●​ Select preferred Contexts for a given rundown. Rundown must be MOS active to show 
up in the drop-down. 

●​ Copying a story from another rundown will trigger the reskinning operation.  
●​ Any MOS object that is not from the preferred context will be replaced by CAMIO if a 

matching template exists.  
●​ The rundown needs to be MOS active to make the reskinning happen.  

Style Reskinning 

 

Style Reskinning only works with PRIME scenes that have two or more style values built in. 

●​ Select preferred Style per Context for a given rundown. 
●​ Copying a story from another rundown will trigger the reskinning operation. 
●​ Any MOS object in the given context that is not in the preferred style will be replaced by 

CAMIO. 
●​ It is possible to create multiple style reskinning rules in the same rundown, one per 

context. 
●​ Note: cannot apply Context Reskinning and Style Reskinning to the same rundown. 
●​ Like with Context Reskinning, the rundown needs to be MOS active to make the 

reskinning happen.  
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PRIME Styles 
Create a list of Style names and bind them to a context. These style names will then be visible 
in the LUCI Style selector drop-down when a PRIME template of the given context is being 
edited. The PRIME Scene must be designed to use the style value or it will be ignored. 

 
Styles shown in the LUCI drop-down for Context = PRIME. 

 

Add Context Styles 
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Configuration 
CAMIO Configuration 
Selecting CAMIO Configuration exposes the options shown below 

 

●​ Asset Manager Max Items to Display – Specifies the maximum number of items to be 
displayed per page (defaults to 20). 

●​ CAMIO IP Address – Specifies the IP Address of the CAMIO system. 
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●​ Render MOS Object Thumbnails with Preview Only Images - Graphics templates 
used by CAMIO often have preview only images built in. These images are displayed in 
the preview but will not play to air. The option selects whether the Preview Only images 
are rendered into the LUCI and CAMIO Rundown Endpoint and Viewer thumbnails. 

●​ Default Frame for Video Asset Thumbnail - Choose between First Frame, Last Frame 
or User Defined to specify which frame should be used for the video asset thumbnail. 
This value can be overridden on an asset by asset basis.  

●​ Generated Proxy Format - Proxy files are generated for preview in Asset Manager and 
LUCI. LUCI4 requires WMV format, LUCI5 requires WEBM format. If unsure, then select 
both.  

●​ Hide Deficient Assets in Asset Manager - Deficient assets are images and movies 
which were ordered from AXIS services (usually Order) and not yet been delivered. They 
are displayed as a deficient asset icon. These can clutter the Asset Manager display 
and checking this box will hide them in Asset Manager. 

●​ Virtual Channels – Display the current Virtual Channels and control which channel is 
displayed by template type. 

○​ Click the corresponding red “X” to delete a virtual channel. 
○​ To add a new Virtual Channel, enter the desired name of the virtual channel into 

the text field and then click Add Virtual Channel. 
○​ Template Channel Mappings - Checkbox grid selects which Virtual Channels are 

visible in LUCI and Asset Manager when using a given template type.  
○​ In this example, Lyric templates will only display channels *, A, B and C as 

options. 
PRIME Clip Templates will only display CLIPS1, CLIPS2, CLIPS3 and CLIPS4.  
PRIME Graphics Templates will only display CG1, CG2, CG3 and CG4. 
If there are no checkboxes checked for a particular template type, then all Virtual 
Ch. will be displayed. In this example, a LyricX template will display all 12 
channel options.  

●​ Layers - applies to PRIME scenes only. Layer values must be positive and negative 
integers. Higher value layers display over lower value layers on the same output 
channel.  

○​ Add Layer - Enter an integer value in the text box and click Add Layer button to 
create a new layer. 
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LUCI Configuration 
Selecting LUCI Configuration exposes the options shown below. 
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General Settings 

●​ iNews Insert, Save, Start and Switch Scripts - The first four settings shown are for 
iNews only and will not be displayed if other newsroom systems are selected in the 
MOS Configuration.  

●​ Max Asset Displayed – Specifies the maximum number of assets displayed visible per 
page in LUCI. 

●​ Message Details – Format of the Message Details shown in LUCI. Asset formatting 
identifiers are shown in the table below.  

●​ Image Details – Format of the Image Details shown in LUCI. 
●​ Video Details – Format of the Video Details shown in LUCI. 
●​ PowerClips Details – Format of the PowerClips Details shown in LUCI. 
●​ AXIS Details – Format of the AXIS Details shown in LUCI. 
●​ Running Order Details – Format of the Running Order Details shown in LUCI. 
●​ Enable Automation Transitions - used in special circumstances. This option displays a 

drop-down list of automation transitions to be selected by the LUCI user. The 
automation transition becomes metadata saved to the MOS Object and read by some 
news automation systems to enable special features. The text in the drop-down list is 
defined in the Automation Transition Configuration section below. 

●​ Disable Replaceable Hashes - used in special circumstances as directed by Chyron 
support. This option disables the use of hashes to uniquely identify replaceable assets. 
This may be necessary when very large movie files are used as replaceable assets.  

●​ Automation Timecode Frame Rate - Configures the frame rate used by the In and 
Duration time code tools in LUCI. When set to 30 fps, the frame count will only roll up to 
29 then add one to the second count. Selectable values are 25, 30, 50 and 60 fps.  

●​ LUCI Saved State Expiration - LUCI feature. There is a clean up script to delete old 
Saved States that have expired. This setting changes the expiration days since the last 
time a given user saved a state on a given workstation (IP Address). 

●​ Disable XMP Link Protection - default to False. 
When set to False the following happens: 

○​ The chain-link button in LUCI will be enabled 
○​ The Data-bound fields will not be editable when the chain-link symbol is linked 
○​ The Data-bound fields will be editable when the chain-link symbol is unlinked 

When set to True the following happens: 
○​ The chain-link button in LUCI will be disabled, but still shown for Data-bound 

fields 
○​ The Data-bound fields will be editable always 

●​ Compositor Output Resolution - default to 1920x1080. To set the generated images’ 
output resolution to 1920x1080 or 1280x720. 

●​ Fast Drag and Drop - default to False. To display the Drag and Drop option 
immediately in LUCI when creating a new graphic. 
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Warning: this option may ask for extra resources to the MOS Management service as 
constantly updating the graphic’s related MOS object values. 

●​ Text Input Font Size - The font size used in LUCI can be changed.. The default is 14pt. 
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MOS Configuration 
Selecting MOS Configuration exposes the options shown below. These settings affect MOS 
communication with the newsroom computer system. 

Important Note: this section describes the needed settings assuming that the playout control 
is handled by Chyron ISQ application. In the case where an external Automation system is used 
such as Vizrt Mosart, Ross OverDrive, Avid Command, Sony ELC etc changes may apply. 
Please consult your Chyron representative for more information. 

 

 

On the MOS Configuration page, the following settings are displayed. Note that these settings 
may be case sensitive so it is recommended to always use capitals. 

●​ MOS Server Type – Select the Newsroom Computer System type (ENPS, Dalet, 
iNEWS, etc.), from the Server Type drop-down box. 

●​ MOS Version - Select MOS Protocol version 2.6 or 2.8.5. Contact Chyron support. 
●​ MOS ID – Enter the MOS ID of the CAMIO server to be used in MOS protocol 

communication with the newsroom computer system .  
●​ NSC ID - Enter the NCS ID of the Newsroom Computer System used in MOS protocol 

communication. 
●​ NCS Server Name – Enter the Hostname or IP Address of the NCS Server, or the 

iNews Gateway in the case of an iNews system. 
●​ Backup NCS Server – Enter the Hostname of the IP Address of the backup NCS 

Server, if applicable. . 
●​ Heartbeat Interval - Enter the desired heartbeat interval in seconds. Should normally 

be set to 0 which disables heartbeats. Contact Chyron support for more information.  
●​ MOS Abstract – Specifies the format for the MOS Abstract as shown in the newsroom 

computer system. Formatting commands for MOS Abstract and Object Slug are shown 
in Appendix. 

●​ Slug – Specifies the format for the Object Slug defined in the MOS Object metadata. 
●​ Default In/Out Time - These values can be defaulted to non-zero in cases where an 

automation system requires it e.g. Ross Overdrive going into Manual mode with zero 
values. The default values will be visible in LUCI. 

●​ Force Edit New – If set to true, a new MOS Object ID will always be created when an 
existing MOS Object is edited. If set to false, then when a MOS Object is edited in LUCI 
and saved, the user is prompted with the option of saving the object under the original 
MOS ID, or creating a new one.  

●​ roChannel Override – Not in use at this time. 
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●​ Socket Persistence – Specifies if the socket connection initiated by CAMIO with the 
NCS server is kept active. Selecting True maintains the socket connection. 

●​ MOS Object Lifetime – MOS Objects are stored in cache for x number of days after the 
last them they were used in a rundown. The object is then deleted from cache. The 
default value is 90 days. 

●​ Listening MOS Lower Port - This is the port CAMIO opens to receive ro messages 
from the NCS. It defaults to 10540 and should not be changed without a specific 
reason. Some MOS installations use non-standard ports.  

●​ Listening MOS Upper Port - This is the port CAMIO opens to receive MOS object 
messages from the NCS. It defaults to 10541 and should not be changed without a 
specific reason. Some MOS installations use non-standard ports.  

●​ Sending MOS Lower Port - This is the port CAMIO connects to on the NCS to send ro 
messages. It defaults to 10540 and should not be changed without a specific reason. 
Some MOS installations use non-standard ports. 

●​ Sending MOS Upper Port - This is the port CAMIO connects to on the NCS to send 
MOS object messages. It defaults to 10541 and should not be changed without a 
specific reason. Some MOS installations use non-standard ports.  

 

Settings for ENPS 8 or 9 

Note: the ENPS side of the configuration should be handled by AP or the customer 

On ENPS side 

Open the ENPS System Maintenance application, go to MOS Configuration, add a new row 
and enter the following settings: 

●​ Address: CAMIO MOS ID 
●​ Description: a user friendly name that will displayed to users, e.g. ‘CAMIO’ 
●​ IP: CAMIO server or DR/Cluster virtual IP 
●​ ActiveX: ‘Chymox.AssetBrowser.1’ (ActiveX) or ‘ENPSHTMLHost’ (HTML5) 
●​ Program: ‘ENPSMOS’ 
●​ Default Settings: nothing (ActiveX) or ‘URL=http(s)://<CAMIO IP>/luci/’ (HTML5) 
●​ MOS Version: ‘2.8.4’ 
●​ Local DragDrop: ‘Off’ 
●​ All other settings can be left as default 
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CAMIO MOS Settings in ENPS System Maintenance 

 

On CAMIO side 

Open the CAMIO Admin page, go to Configuration > MOS Configuration and enter the 
following minimum settings: 

●​ MOS Server Type: ENPS 
●​ MOS Version: 2.8.5 
●​ MOS ID: CAMIO MOS ID 
●​ NCS ID: ENPS Server Hostname 
●​ NCS Server Name: ENPS Server hostname or IP 
●​ Backup NCS Server: ENPS Backup Server hostname or IP if applicable 
●​ MOS Abstract (advised but not mandatory value): ‘%m %s(%t)’ 
●​ Slug (advised but not mandatory value): ‘%m - %s(%t) %0 %1 %2 %3 %4 %5 %6 %7 

%8 %9’ 
●​ All other settings can be left as default 
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ENPS MOS Settings in CAMIO Admin 

 

Settings for iNews 

Note: the iNews side of the configuration should be handled by Avid or the customer 

On iNews side 

MOS Gateway 

Note: If Avid Command is used for the Playout Automation of Prime, most likely the iNews 
MOS Gateway would not be needed as iNews would directly transmit the Rundown to 
Command with its own protocol, while CAMIO will push to Prime every created MOS Object, 
thus ready to be played. 
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In C:\Program Files (x86)\Avid\iNEWS MOS Gateway edit the mosconfig.xml file to add a new 
<mosDevice> with its children elements under <listDevices>. The <mosDevice> is as follow, 
with the mandatory values to update in red and optional in black: 

<mosDevice> 
​ <!-- The names element contains the mapping of the MOS's mosID value to --> 
​ <!-- an NRCS device name, as well as the network name of the MOS. --> 
​ <names> 
​ ​ <mos>CAMIO MOS ID</mos> 
​ ​ <amcp>INEWS ALIAS</amcp> 
​ ​ <network>CAMIO HOSTNAME OR IP</network> 
​ </names> 
​ <!-- Running order channel maps --> 
​ <roChannels> 
​ ​ <roChannel> 
​ ​ ​ <iNewsChannel>A</iNewsChannel> 
​ ​ ​ <MosDevChannel>A</MosDevChannel> 
​ ​ </roChannel> 
​ ​ <roChannel> 
​ ​ ​ <iNewsChannel>B</iNewsChannel> 
​ ​ ​ <MosDevChannel>B</MosDevChannel> 
​ ​ </roChannel> 
​ </roChannels> 
​ <!-- Maps a NRCS Running Order Name to a more readable MOS roSlug. --> 
​ <!-- A NRCS Running Order Name is the NRCS server name plus the --> 
​ <!-- running order's complete queue path. If a mapping doesn't exist --> 
​ <!-- then the NRCS Running Order Name is used for the MOS roSlug. --> 
​ <roSlugMaps> 
​ ​ <roSlugMap> 

<iNewsRunningOrderName>INEWS_SERVER/SHOW.7AM.RUNDOWN</iNewsR
unningOrderName> 

​ ​ ​ <MOSroSlug>7AM</MOSroSlug> 
​ ​ </roSlugMap> 
​ </roSlugMaps> 
​ <!-- The handlesEmptyStories element specifies whether this device accepts --> 
​ <!-- a roStoryInsert message that contains no item. --> 
​ <handlesEmptyStories>YES</handlesEmptyStories> 
​ <!-- The handlesRoStoryMoveMultiple element specifies whether this device supports --> 
​ <!-- the roStoryMoveMultiple message. The router defaults to YES. --> 
​ <!-- Valid settings are YES or NO --> 
​ <handlesRoStoryMoveMultiple>NO</handlesRoStoryMoveMultiple> 
​ <!-- The handlesRoItemLevelCommands element specifies whether this device supports --> 
​ <!-- roItemInsert, roItemDelete and roItemReplace. The router defaults to YES. --> 
​ <!-- Valid settings are YES or NO --> 
​ <handlesRoItemLevelCommands>NO</handlesRoItemLevelCommands> SET YES FOR MOS 2.8 
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​ <!-- If YES then the stories page number from NRCS is prepended to the story --> 
​ <prependPageNumber>YES</prependPageNumber> 
​ <!-- The character seperator used between the page number and the story slug.--> 
​ <prependSeparator>@</prependSeparator> 
​ <!-- The character string which is used in place of an empty page number.--> 
​ <prependStringForEmptyPageNumber>##</prependStringForEmptyPageNumber> 
​ <!-- When set to NO, all MOS items in the rundown will be contained within --> 
​ <!-- the roCreate message.  When set to YES, a blank roCreate message is sent --> 
​ <!-- and all MOS items in the rundown will be added using roStoryInsert --> 
​ <!-- messages.  The recommended setting is NO unless it is absolutely required. --> 
​ <sendRoCreateOnStartLoad>NO</sendRoCreateOnStartLoad> 
​ <handlesSpecMosReqAll>YES</handlesSpecMosReqAll> 
​ <!-- The statusTranslations element defines the status strings that correspond --> 
​ <!-- to the various NRCS status codes. This allows the MOS Gateway to translate --> 
​ <!-- the roItemStatus messages received from a MOS into status codes that NRCS --> 
​ <!-- can recognize and display. --> 
​ <!-- Should we ignore the item status in roAck messages? --> 
​ <!-- Valid settings are YES or NO, default is NO --> 
​ <ignoreItemStatusInRoAck>NO</ignoreItemStatusInRoAck> 
​ <!-- Does this device expect the MOS 2.8 version of roListAll --> 
​ <!-- Valid settings are YES or NO, default is NO --> 
​ <handlesRoListAll28>NO</handlesRoListAll28> SET YES FOR MOS 2.8 
​ <!-- Does this device handle roStorySend messages? --> 
​ <!-- The handlesRoStorySend element specifies whether this device supports --> 
​ <!-- sending storys via roStorySend. The router defaults to NO. --> 
​ <!-- Valid settings are YES or NO --> 
​ <handlesRoStorySend>NO</handlesRoStorySend> 
​ <!-- The handlesRoStorySendNSMLX element specifies whether this device supports --> 

<!-- sending the NSMLX via the roStorySend mosExternalMetadata payload. The router defaults 
to NO. --> 

​ <!-- Valid settings are YES or NO --> 
​ <handlesRoStorySendNSMLX>NO</handlesRoStorySendNSMLX> 
​ <!-- The retry timeout in seconds for this device. --> 
​ <!-- Set to 0 if you do not want to have retries --> 
​ <!-- Valid values: 0 - 214748647 --> 
​ <!-- Default is 0 --> 
​ <retryTimeout>0</retryTimeout> 
​ <statusTranslations> 
​ ​ <statusUnknown>UNKNOWN</statusUnknown> 
​ ​ <statusUnavailable>NOT READY</statusUnavailable> 
​ ​ <statusUnavailable>DELETED</statusUnavailable> 
​ ​ <statusAvailable>READY</statusAvailable> 
​ ​ <statusAvailable>NEW</statusAvailable> 
​ ​ <statusCued>CUED</statusCued> 
​ ​ <statusPlaying>PLAY</statusPlaying> 
​ ​ <statusPaused>PAUSE</statusPaused> 
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​ ​ <statusStopped>STOP</statusStopped> 
​ ​ <statusTensionReleased></statusTensionReleased> 
​ ​ <statusPlayRequested></statusPlayRequested> 
​ ​ <statusRewinding></statusRewinding> 
​ </statusTranslations> 
​ <mosObjReplication> 
​ ​ <trigger>manual</trigger> 
​ ​ <replicationTime>12:31:15 PM</replicationTime> 
​ ​ <clearQueue>true</clearQueue> 
​ ​ <path>mos.mosdevicename</path> 
​ ​ <mosItemBrowserProgID></mosItemBrowserProgID> 
​ ​ <mosItemEditorProgID></mosItemEditorProgID> 
​ </mosObjReplication> 
​ <!-- Valid settings are YES or NO --> 
​ <AllowMosObjCreate>NO</AllowMosObjCreate>​  
</mosDevice> 
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HTML view of the mosconfig.xml 

 

iNews Server 

Host Table (/etc/hosts): enter the IP/Hostname for the CAMIO and the iNews MOS Gateway 
servers 
 

iNews Client with Administrator privileges 

●​ SYSTEM.MOS-MAP – sets the MOS ID and AMCP ID 
  

TABLE-START DeviceTable 
<CAMIO MOS ID> <CAMIO INEWS ALIAS> <CHANNEL> <CHANNEL> … 
TABLE-END 
Example: 
TABLE-START DeviceTable 
CAMIO CG40 A B C D 
TABLE-END 

  
 
  

●​ SYSTEM.MAP - sets the Gateway and iNews Alias per Rundown. 
  

show.<QUEUE>.rundown   <event dir> <composite> <group> <off time> 
mossvr   <INEWS MOS GATEWAY HOSTNAME>  <backup server> <CAWS form> 

mos   <CAMIO INEWS ALIAS>  <devices for redirection> 
 

<event dir> (optional):  Event list directory. See iNews documentation for details. 
<composite> (optional): Composite list queue. See iNews documentation for details. 
<group> (optional): to set Security groups. See iNews documentation for details. 
<off time> (optional):  the time the show’s monitor server turns itself off. See iNews 
documentation for details. 
<backup Server> (optional): for secondary MOS Gateways 
<CAWS form> (optional): for ControlAir workstations, not used here 
<devices for redirection> (optional): for MOS Redirection use 
 
Example of minimal working configuration: 
show.training.rundown​ -​ - ​ - ​ - 
mossvr​​ MOSGW​ -​ - 

mos​ CG40​ ​ - 
 
 

●​ SYSTEM.KEYBOARDS.<Users Keyboard(s)> - Shortcuts for Insert/Replace from LUCI 
(LUCI Container only) 
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@{shift{ctrl{alt{f1}}}}~{alt s n c} ;chyron 
@{shift{ctrl{alt{f2}}}}~{alt s n c} ;chyron 
@{shift{ctrl{alt{f3}}}}~{alt s n c} ;chyron 

 
Note: Alt->S->N->C is the keyboard sequence to trigger the Story > Import from 
Plugin > ChyronHego Luci action in iNews, it may differ depending on the iNews 
version and language. 
Shift+Ctrl+Alt+F1/F2/F3 refers to the usual settings in Camio Admin > Configuration 
> LUCI Configuration, to be adapted if different: 
 

 
 
 

Use of the iNews HTML5 Plugin with LUCI 

HTML5 Plugin is available since iNews 8 and can be used in replacement of the LUCI 
Container. It is configured using a story in the queue SYSTEM.HTML-PLUGINS within an 
iNews Client with admin privileges, with the following content as parameters: 
 

URL = http(s)://<CAMIO IP or hostname>/luci?noinsertreplace=true 
mosItemBrowserProgID=Chymox.AssetBrowser.1 
mosItemEditorProgID=Chymox.AssetBrowser.1 
mosItemPlayerProgID=Chymox.AssetBrowser.1 

Note: as ActiveX takes precedence over HTML5 for the same ProgID, it is necessary to 
uninstall the LUCI Container application if present on the workstations running iNews Client. 

Enabling Developer Tools: 

●​ Open the Windows registry editor. 
●​ Navigate to: 

Computer\HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session 
Manager\Environment 

●​ If not present, add the registry key UseChromiumRemoteDebug (DWORD). 
●​ Set the registry key to a value of 1 to enable access to the Developer Tools. Note: 

setting the registry key to a value of zero or removing it will disable access to the 
Developer Tools. 

●​ Access to Developer Tools: Open Google Chrome web browser. While the plugin is 
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active inside iNEWS Workstation, navigate to the URL: http://localhost:8088/ 

 
 

On CAMIO side 

Open the CAMIO Admin page, go to Configuration > MOS Configuration and enter the 
following minimum settings: 

●​ MOS Server Type: INEWS 
●​ MOS Version: 2.6 or 2.8.5 (see MOS Gateway configuration) 
●​ MOS ID: CAMIO MOS ID 
●​ NCS ID: iNews Server Hostname without -a or -b 
●​ NCS Server Name: iNews MOS Gateway hostname or IP 
●​ Backup NCS Server: iNews Backup MOS Gateway hostname or IP if applicable 
●​ MOS Abstract (advised but not mandatory value): ‘%m %s(%t)’ 
●​ Slug (advised but not mandatory value): ‘%m - %s(%t) %0 %1 %2 %3 %4 %5 %6 %7 

%8 %9’ 
●​ All other settings can be left as default 
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iNews MOS Settings in CAMIO Admin 

Settings for iNews with Command automation 

Note: the iNews side of the configuration should be handled by Avid or the customer 

If Avid Command is used for the Playout Automation of Prime, most likely the iNews MOS 
Gateway would not be needed as iNews would directly transmit the Rundown to Command 
with its own protocol, while CAMIO will push to Prime every created MOS Object, thus ready to 
be played. 

On iNews side 

iNews Client with Administrator privileges 

●​ SYSTEM.MOS-MAP – sets the MOS ID and AMCP ID 
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TABLE-START DeviceTable 
<CAMIO MOS ID> <CAMIO INEWS ALIAS> 
TABLE-END 
 
Example: 
TABLE-START DeviceTable 
CAMIO CG40 
TABLE-END 

  
 
  

●​ SYSTEM.MAP - sets the Gateway and iNews Alias per Rundown. 
  

show.<QUEUE>.rundown   <event dir> <composite> <group> <off time> 
wnasvr​​ <COMMAND HOSTNAME>​   <backup server> <CAWS form> 

cg <CAMIO INEWS ALIAS> <alias name> <default channel> <style> <validate 
style YES/NO> 

  
​ <event dir> (optional):  Event list directory. See iNews documentation for details. 

<composite> (optional): Composite list queue. See iNews documentation for details. 
<group> (optional): to set Security groups. See iNews documentation for details. 
<off time> (optional):  the time the show’s monitor server turns itself off. See iNews 
documentation for details. 
<backup Server> (optional): for secondary MOS Gateways 
<CAWS form> (optional): for ControlAir workstations, not used here 
<alias name> (optional): not used 
<default channel> (mandatory): to specify the default channel assigned if the production 
cue does not have one explicitly defined. 
<style> (optional): Style used on the playout device 
<validate style YES/NO> (optional): when set to NO, the monitor server in iNEWS will 
not validate style names before sending CG data to Command. This allows the loading 
of CG items to the Command playlist before they exist in Command’s inventory. If left 
blank, the default, which is YES, is used. 

 
 
Example of minimal working configuration: 
show.training.rundown​ -​ - ​ - ​ - 
wnasvr​​ CMD01​ -   ​ - 

cg   ​ CG40  ​​ -   ​ A​ NEWS​ ​ NO 
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On CAMIO side 

Open the CAMIO Admin page, go to Configuration > MOS Configuration and enter the 
following minimum settings: 

●​ MOS Server Type: INEWS Command 
●​ MOS Version: 2.6 or 2.8.5 (not important in such case) 
●​ MOS ID: CAMIO MOS ID 
●​ NCS ID: iNews Server Hostname without -a or -b 
●​ NCS Server Name: (can be left empty in such case) 
●​ Backup NCS Server: (can be left empty in such case) 
●​ MOS Abstract (advised but not mandatory value): ‘%m %s(%t)’ 
●​ Slug (advised but not mandatory value): ‘%m - %s(%t) %0 %1 %2 %3 %4 %5 %6 %7 

%8 %9’ 
●​ All other settings can be left as default 
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iNews MOS Settings in CAMIO Admin 

Note - Some versions of iNews have introduced issues with the CAMIO MOS Server Types 

●​ CAMIO 5.4.5 INEWS 9+ mode does not work with iNews9. Select the INEWS option 
instead. 

Settings for OpenMedia 

Note: the OpenMedia side of the configuration should be handled by CGI or the customer 

On OpenMedia side 

Open the OMIS.msc, go to OMIS Service Instances and stop the service running CAMIO 
Plugin. Then in OMIS Plugin Types select the Chyron Plugin, right-click on its sub element and 
select Properties. 

 

OpenMedia OMIS Application 

 

Enter the following settings: 

●​ General > Plug-in Name: “CAMIO” 
●​ MOS Device > MOSID: CAMIO MOS ID 
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●​ MOS Device > MOSRevision: 2.84 
●​ MOS Device > Hostname: CAMIO Server Hostname or IP 

Extra settings might need to be added/modified depending on the customer’s environment, to 
be done with a representative from OpenMedia. 

Note: when loading a Rundown for Playout, the graphic items’ MosExternalMetadata should 
be transmitted and with a particular XML structure that can be parsed by Camio. 

●​ To enable the export of the MosExternalMetadata data, set the OMIS plugin as follow: 

 

OMIS Settings for exporting MEM Item 

●​ The expected structure by CAMIO and ISQ with important element is as follow: 

… 
<mosExternalMetadata> 
​ <mosScope>PLAYLIST</mosScope> 

<mosSchema>http://ncsA4.com/mos/supported_schemas/NCSAXML2.08</mosSchema> 
​ <mosPayload> 
​ ​ <createdBy>...</createdBy> 
​ ​ <subtype>...</subtype> 
​ ​ <subtypeid>...</subtypeid> 
​ ​ <ObjectDetails> 
​ ​ ​ ... 
​ ​ </ObjectDetails> 
​ ​ <dataMessage> 
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​ ​ ​ ... 
​ ​ ​ <properties> 
​ ​ ​ ​ ... 
​ ​ ​ </properties> 
​ ​ </dataMessage> 
​ </mosPayload> 
</mosExternalMetadata> 
… 
 

​ To achieve this, the following XSL can be used (and modified) if needed: 

<xsl:stylesheet xmlns:xsl="http://www.w3.org/1999/XSL/Transform" 
xmlns:cg="http://www.mosprotocol.com/charactergenerator_parameters"  
xmlns:vbs="urn:schemas-sqlxml-org:vbs" xmlns:msxsl="urn:schemas-microsoft-com:xslt" 
xmlns:user="http://ann.com/annspace" version="2.0"> 
​ <xsl:output method="xml" omit-xml-declaration="yes" /> 
​ <xsl:template match="/"> 
​ <xsl:apply-templates 
select="OM_RECORD/OM_OBJECT/OM_HEADER/OM_FIELD/OM_STRING/mosPayload/node()"/>         
     </xsl:template> 
​  ​ <xsl:template match="mosPayload/node()"> 
​         <xsl:copy> 
            <xsl:apply-templates select="@*|node()"/> 
        </xsl:copy>         
     </xsl:template> 
​      <xsl:template match="@*|node()"> 
        <xsl:copy> 
            <xsl:apply-templates select="@*|node()"/> 
        </xsl:copy> 
    </xsl:template> 
</xsl:stylesheet> 
 

​ To be saved as a .xsl file and added into the OMIS plugin here: 

 

XSL Transformation for MEM Item 
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Under C:\inetpub\wwwroot\ExternalTools\ChyronWrapper should be located the HTML 
pages for loading LUCI within the OpenMedia client. They contain the following variable 
declarations that need to be modified: 

●​ var DEVICE_URL ​ ​ ​ = "http(s)://<CAMIO Hostname or IP>/luci"; 
●​ var NCS_ID​ ​ ​ ​ = "OpenMedia NCS ID"; 
●​ var MOS_ID​ ​ ​ ​ = "CAMIO MOS ID"; 

 

 

HTML plugins in OpenMedia Client 

 

On CAMIO side 

Open the CAMIO Admin page, go to Configuration > MOS Configuration and enter the 
following minimum settings: 

●​ MOS Server Type: OpenMedia 
●​ MOS Version: 2.8.5 
●​ MOS ID: CAMIO MOS ID 
●​ NCS ID: OpenMedia NCS ID 
●​ NCS Server Name: OpenMedia Server hostname or IP 
●​ Backup NCS Server: OpenMedia Backup Server hostname or IP if applicable 
●​ MOS Abstract (advised but not mandatory value): ‘%m %s(%t)’ 
●​ Slug (advised but not mandatory value): ‘%m - %s(%t) %0 %1 %2 %3 %4 %5 %6 %7 

%8 %9’ 
●​ All other settings can be left as default 

 

70 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      



 

 

OpenMedia MOS Settings in CAMIO Admin 

 

Settings for Octopus 

Note: the Octopus side of the configuration should be handled by Dalet or the customer 

On Octopus side 

Open the Octopus Client with Administrator privileges, under Administration > MOS Devices 
> Devices create a new Device with at minimum the following settings: 

●​ Basic Tab: 
○​ mosID: CAMIO MOS ID 
○​ ncsID: Octopus NCS ID 
○​ Version: 2.8.5 
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○​ Media Host: CAMIO hostname 
○​ Media Port: 10540 (unless specific configuration) 
○​ Rundown Host: CAMIO hostname 
○​ Rundown Port: 10540 (unless specific configuration) 

 

Basic Tab 

 

●​ MOS objects Tab: 
○​ Allow mosItemReplace: checked 
○​ Send mosExternaleMetadata of MOS objects: PLAYLIST 
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MOS objects Tab 

 

●​ Activations Tab: 
○​ Edit the listed Rundown Plan(s), check Enabled and optionally add a Range 

 

 

73 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      



 

Activations Tab 

●​ Plugins Tab: click Add to open the new Plugin window and enter the following: 
○​ Short name: enter a user friendly name for the plugin, e.g. ‘LUCI’ 
○​ Long name: enter a description for the plugin, e.g. ‘LUCI HTML PLUGIN’ 
○​ Width: plugin window width, e.g. ‘1024’ 
○​ Height: plugin window height, e.g. ‘768’ 
○​ Type: Browser 
○​ Version: 2.8_Web 
○​ Platform: Chrome (CEF) 
○​ Implementation: LUCI URL: http(s)://<Camio hostname>/luci 

 

Plugin Window 
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On CAMIO side 

Open the CAMIO Admin page, go to Configuration > MOS Configuration and enter the 
following minimum settings: 

●​ MOS Server Type: Octopus 
●​ MOS Version: 2.8.5 
●​ MOS ID: CAMIO MOS ID 
●​ NCS ID: Dalet NCS ID 
●​ NCS Server Name: Octopus Server hostname or IP 
●​ Backup NCS Server: any secondary Octopus Server hostname or IP 
●​ MOS Abstract (advised but not mandatory value): ‘%m %s(%t)’ 
●​ Slug (advised but not mandatory value): ‘%m - %s(%t) %0 %1 %2 %3 %4 %5 %6 %7 

%8 %9’ 
●​ All other settings can be left as default 
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Octopus MOS Settings in CAMIO Admin 

 

Settings for Dalet Galaxy 

Note: the Dalet side of the configuration should be handled by Dalet or the customer 

On Dalet Galaxy side 

Open the Dalet Admin tool, under Mos Admin > Mos Devices there should be a device of type 
‘Chyron CAMIO HEGO’ with at minimum the following settings: 

●​ MOS ID: CAMIO MOS ID 
●​ Host: CAMIO hostname 
●​ Low Port: 10540 (unless specific configuration) 
●​ High Port: 10541 (unless specific configuration) 

 

CAMIO MOS Device in Dalet Admin 

 

In Title Management > Title Types > Extended Title Type there should be a ‘Chyron CAMIO 
HEGO’ title type with the following settings: 

●​ MediaType: CG 
●​ Reuse action in stories and rundowns: LINK 
●​ Editor: MosActiveX 
●​ Title can be created: Yes 
●​ Title Type Icon: if needed, add Chyron logo there 
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Title Types in Dalet Admin 

 

Still in Title Types under Story & Story Templates, select the Story Types where Chyron 
graphics should be used and add the corresponding Chyron CAMIO HEGO Title Type in 
Embedded Title Types. 
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Embedded Title Types in Dalet Admin 

 

In Scheduling > Studio, select the Studio where Chyron graphics will be used, select the 
External Devices tab and add the corresponding CAMIO MOS Device 
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External Devices in Dalet Admin 

 

In Site Configuration > Inventory > Application Servers, double-click on the MosServer 
application and check the following minimum settings: 

●​ ncsID: Dalet NCS ID that will be set in CAMIO MOS settings 
●​ Dalet operates as: Newsroom Control System 
●​ Low port: 10540 (unless specific configuration) 
●​ High port: 10541 (unless specific configuration) 
●​ MOS Devices: CAMIO MOS Devices selected 
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MosServer in Dalet Admin 

 

On CAMIO side 

Open the CAMIO Admin page, go to Configuration > MOS Configuration and enter the 
following minimum settings: 

●​ MOS Server Type: Dalet 
●​ MOS Version: 2.6 
●​ MOS ID: CAMIO MOS ID 
●​ NCS ID: Dalet NCS ID 
●​ NCS Server Name: Dalet Server hostname or IP where the MosServer is located 
●​ Backup NCS Server: any secondary Dalet MosServer hostname or IP 
●​ MOS Abstract (advised but not mandatory value): ‘%m %s(%t)’ 
●​ Slug (advised but not mandatory value): ‘%m - %s(%t) %0 %1 %2 %3 %4 %5 %6 %7 

%8 %9’ 
●​ All other settings can be left as default 
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Dalet MOS Settings in CAMIO Admin 

 

Settings for Ross Inception 

Note: the Inception side of the configuration should be handled by Ross or the customer 

On Inception side 

Open Inception Configuration tool, under MOS > Devices create a new Device with at 
minimum the following settings: 

●​ Device Settings: 
○​ MOS ID: CAMIO MOS ID 
○​ Host: CAMIO Hostname or IP 
○​ MOS Version: 2.6 or 2.8.5 (preferred) 
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○​ Name: CAMIO (or any other user friendly) 

 

Device Settings 

 

●​ Appearance: 
○​ Icon: add a Chyron icon 

●​ MOS Settings: 
○​ None 
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Appearance and MOS Settings 

 

●​ MOS Plugin: Web Plugin 

●​ Web Plugin: 
○​ URL: https://<CAMIO Hostname>/luci 
○​ Use Single Sign-On: Yes 
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MOS Plugin and Web Plugin 

 

On CAMIO side 

Note: CAMIO has to be installed with LUCI in HTTPS mode. 

Open the CAMIO Admin page, go to Configuration > MOS Configuration and enter the 
following minimum settings: 

●​ MOS Server Type: Ross Inception (iRB as alternative) 
●​ MOS Version: 2.6 or 2.8.5 (preferred) 
●​ MOS ID: CAMIO MOS ID 
●​ NCS ID: Inception NCS ID 
●​ NCS Server Name: Inception Server hostname or IP 
●​ Backup NCS Server: any secondary Inception Server hostname or IP 
●​ MOS Abstract (advised but not mandatory value): ‘%m %s(%t)’ 
●​ Slug (advised but not mandatory value): ‘%m - %s(%t) %0 %1 %2 %3 %4 %5 %6 %7 

%8 %9’ 
●​ All other settings can be left as default 
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Ross Inception MOS Settings in CAMIO Admin 

 

Settings for 7Mountains Dina 

Note: the Dina side of the configuration should be handled by 7Mountains or the customer 

On Dina side 

The LUCI plugin integration is managed by Dina representatives. It should be set as HTTPS. 

The 7M MOS Gateway acts as a middleware between Dina and CAMIO, to be installed on a 
server within the same subnet of the CAMIO system, preferably on a separate machine. More 
information about the 7M MOS Gateway here. 

The MOS section of the 7M MOS Gateway prod.json configuration file should be set as follow: 

 

85 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      

https://drive.google.com/file/d/1Hq2PI5jyvlxnVVPr_F6x1ttrFmHUBgWx/view?usp=sharing


 

"mos": { 
    "ncsID": "DINA NCS ID", 
    "lowerPort": 10540, 
    "heartbeatInterval": 60, 
    "messageIdFilename": "./messageId.data", 
    "media": { 
      "secondaryGraphics": "replace", 
      "useProviderMosObject": false 
    }, 
    "storyContent": { 
      "roElementAction": true, 
      "roStorySend": false 
    }, 
    "sendMessageDelay": 50, 
    "brackets": { 
      "ignoreText": "[]", 
      "explanatoryText": "()", 
      "presenterInstruction": "{}", 
      "packageText": "<>", 
      "defaultText": "" 
    }, 
    "prompter": { 
      "templateText": "#name" 
    }, 
    "clients": [ 
      { 
        "ipAddress": "CAMIO IP", 
        "lowerPort": 10540, 
        "mosId": "CAMIO MOS ID", 
        "autoConnect": true, 
        "reconnectInterval": 10, 
        "allowedMosObjects": [“CAMIO MOS ID”], 
        "timeFormat": "utc", 
        "decimalMarker": ".", 
        "storyContent": { 
​ "roElementAction": true, 
​ "roStorySend": false 
        } 
      } 
    ] 
  } 
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On CAMIO side 

Open the CAMIO Admin page, go to Configuration > MOS Configuration and enter the 
following minimum settings: 

●​ MOS Server Type: Dina 
●​ MOS Version: 2.8.5 
●​ MOS ID: CAMIO MOS ID 
●​ NCS ID: Dina NCS ID 
●​ NCS Server Name: 7M MOS Gateway Server hostname or IP 
●​ Backup NCS Server: 7M MOS Gateway Backup Server hostname or IP if applicable 
●​ MOS Abstract (advised but not mandatory value): ‘%m %s(%t)’ 
●​ Slug (advised but not mandatory value): ‘%m - %s(%t) %0 %1 %2 %3 %4 %5 %6 %7 

%8 %9’ 
●​ All other settings can be left as default 
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Dina MOS Settings in CAMIO Admin 

 

Playlist Configuration 
Selecting Playlist Configuration exposes the options shown below. These settings affect the 
display of playlist data in the legacy Lyric playlist and some effect on what gets sent to ISQ. 
The four Blank Fields at the end of the list can be used in configuring the CAMIO Rundown 
Endpoint and Viewer display. See the CAMIO Rundown Endpoint and Viewer manual for more 
information​  

 

On the Playlist Configuration page, the following settings are displayed: 

●​ Control - Specifies the default Playlist Control. The Control determines the trigger that 
sends the message to Air. 

●​ Parameter - Specifies the default Playlist Parameter for the specified Control. For 
example, if a delay is specified, the Parameter value could be 00:00:00:15, indicating 
that there should be a half-second delay before the message plays to Air. Not all 
Controls have an accompanying Parameter. 

●​ Effect - Specifies the default effect to be applied to the messages in the Playlist when 
they play to Air. This is a legacy feature no longer supported.  

●​ File Name – This is a read-only field that can be displayed in the Playlist. It identifies the 
file name and file path of the message. 

●​ Additional Fields - the four blank fields can be used to display a rich selection of 
additional information in both the Lyric playlist and the CAMIO Rundown Endpoint and 
Viewer. The information that can be displayed follows the metadata formatting rules 
shown in the Table below. Commonly used fields are:  

○​ Slug field is most commonly used and maps to the Description field in the 
CAMIO Rundown Endpoint and Viewer.  

○​ Page is used to display the story slug or page number in Lyric Playlist and in 
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some versions of the CAMIO Rundown Endpoint and Viewer. 

In all instances, the Width column specifies the width, in pixels, of the column on the Lyric 
Playlist displaying the specified information. The State column specifies whether the column 
will be shown or hidden. 

 

 

89 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      



 

FileSync Configuration 
 
FileSync is a Dropbox-style folder synchronization system used to distribute graphics content 
to playout devices on the CAMIO network. It is important to understand the difference between 
the assets managed by CAMIO and the assets managed by FileSync.  
 
CAMIO Managed Assets - CAMIO manages the graphics templates, replaceable images and 
replaceable movie files. The producer uses these files to create MOS objects, using the MOS 
Plugin LUCI. CAMIO distributes these assets and the MOS Objects to playout devices that are 
mapped to a context in the device channel mapping. 
 
FileSync Managed Assets - Lyric, PRIME and other graphics systems have many files 
required to play back a graphic. These can be graphics templates (as opposed to CAMIO 
templates) clip files, image files, etc. These are not the assets visible in LUCI, but are the 
graphics required to play the base message. These files are usually in a folder structure called 
the project files or package files.  
 
HubDrive installation, configuration and operation is covered in a separate document: CAMIO 
Filesync User Guide. 
 
 

 

Media Engine Configuration 

Enter the IP address of the Media Engine host which is the CAMIO server itself. So the IP 
address of the CAMIO server should be entered. 
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The Output Folder is a temporary folder for the Save to LUCI feature in the Render Media 

workflow. It should be defined on the i drive of the CAMIO Server. If this folder is not on the 

CAMIO server itself it must be entered as a network share file path (such as 

//10.10.24.31/Media_Engine_Output), and the folder must be shared to CAMIO.  
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LUCI User Defaults Configuration 
This section allows users to specify the default configuration used in the LUCI User Settings 
shown above. Selecting LUCI User Defaults Configuration exposes the options shown 
below. 
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●​ Graphics Templates - Display or hide the Graphics Templates selection under the 
Browse Templates Tab. 

●​ Completed Graphics - Display or hide the Complete Graphics selection under the 
Browse Templates Tab. 

●​ Automation Templates - Display or hide the Automation selection under the Browse 
Templates Tab. . 

●​ Studio Clips - Display or hide Studio Clips selection under the Browse Templates Tab. . 
●​ Running Orders - Display or hide the Running Order drop-down box and the ability to 

view Running Orders. 
●​ AXIS Track in Asset Browser - Display or hide AXIS Track assets in the Asset Browser. 

Applies to user with AXIS Track accounts only.  
●​ Compose Images - Display or hide the Image Compositing tool.  
●​ Compose Movies - Display or hide the Movie Compose tool. This feature is not yet 

available.panel 
●​ Order – Display or hide AXIS Track assets in the Asset Browser. Applies to users with 

AXIS Order accounts only.  
●​ Render Media - Display or hide the Render Media button in the right side panel. 
●​ Timecode -Display or hide the timecode In, Duration and Out controls. 
●​ Slug - Display or hide the Slug field for additional text entry to describe the MOS object 

graphics. 
●​ Channel - Display or hide the virtual channels display and selection tool. 
●​ Delivery Feed - Display or hide the delivery status of assets from the AXIS system. 

Applies to users with AXIS accounts only.  
●​ Enable Auto Preview - Enables/disables the auto-preview feature where a preview is 

automatically generated in LUCI whenever there is a change to the replaceable values 
●​ Animate Preview - Add something here 

o​ Creates a 5-second animated preview in LUCI 
●​ Publishing - Display or hide the Publishing button in the right side panel. This feature is 

not yet available. 
●​ Saved Items - Display or hide the Save Items feature. This includes the Save Item 

button on the right side panel and the Saved Items tab along the top row. 
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Global Filters 

Global Filter Table – This table displays the Name, Context Name, Asset Types and Filter 
Description of previously created global filters. 

Create New Global Filter - opens a new window in order to determine the parameters of the 
desired filter. 

 

●​ Name – Determine the name of the new global filter. 
●​ Context – Use the drop-down menu to determine which Context is to be filtered. 
●​ Asset Types – Check the type of Assets that are to be filtered. 
●​ Filter Description – the left-hand drop-down box is used to determine the parameters 

of the filter (Author, Description, Keywords, Subject or Title). The middle drop-down 
box is used to determine whether the filter will Contain or Doesn’t Contain a string that 
is specified in the text box on the right. 

●​ And/Or – Selecting And will instruct the filter to also include the following separate filter 
description along with the previous one. Selecting Or will instruct the filter to include the 
following separate filter if the previous one does not yield any results. 

●​ From Date – Allows the user to specify a date where the filter is to begin searching. 
●​ To Date – Allows the user to specify a date where the filter is to end searching. 
●​ From Rolling Date – Allows the user to determine a continually updating date from 

which the filter is to search (Today, Last 2 Days, Last 4 Days, Last Week, Last Month, 
Last 6 Months, Last Year). 
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Job Schedule Configuration 
Selecting Job Schedule Configuration exposes the options shown below. There are currently 
eight different jobs that may be run.  The jobs can be run manually by pressing the Run Now 
button or they will run at a scheduled time. 

 

 

Daily MOS Object Cleanup Jobs  

One of the following three jobs is typically run daily to clean up old MOS Objects from CAMIO 
device cache and playout devices. These perform slightly different tasks. Only one of these 
three jobs should be run. Please contact Chyron support for assistance in selecting which 
cleanup job will be run. 

●​ Device Cleanup deletes all MOS Objects and associated assets which are no longer 
being used by active rundowns from the playout folders of all playout devices. This 
prevents these folders from getting full over time, which can lead to performance 
issues.It also removed the MOS Objects from a list of active objects monitored by 
CAMIO, which reduces the load on CAMIO’s MOS Object management service. This 
cleanup job is most often recommended  

●​ CAMIO Cleanup removes unused MOS Objects from the list of active objects 
monitored by CAMIO. But, it does not delete the inactive MOS Objects and associated 
assets from the playout devices. This job is typically used when the newsroom system 
does not have a MOS Gateway or does not publish an active rundown. It is necessary 
in this case to manually delete old assets to keep the playout folder from getting too 
large. 

●​ Device Synchronize does a further check for and deletes all files in the CAMIO4 
directory of playout devices which are not needed by active MOS Objects. For instance, 
it will delete Lyric files which were placed there by a manual operator.  
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Mandatory Cleanup Jobs 

These jobs must be run daily but the time of day can be configured as desired.  

●​ Saved Items Cleanup - Removes Saved Items from the Saved Items folders after they 
have expired. For instance, if an item was added to Saved Items at 4PM on Tuesday 
with a 24 hour life, it will expire at 4PM on Wednesday and will be deleted the next time 
the script is run, i.e. 2AM Thursday. An item that is removed from Saved Items will not 
immediately be deleted from cache. That is up to the MOS Object Cleanup script, 
depending on how that is configured.  

●​ LUCI Saved State Cleanup - Cleans up LUCI Saved States which have expired. The 
expiration defaults to 90 days and can be changed in Admin Tools > LUCI Client 
Configuration.  

Other Cleanup Jobs 

●​ Saved Items Cleanup - This script removes Saved Items from the Saved Items folders 
after they have expired. For instance, if an item was added to Saved Items at 4PM on 
Tuesday with a 24 hour life, it will expire at 4PM on Wednesday and will be deleted the 
next time the script is run, i.e. 2AM Thursday. An item that is removed from Saved Items 
will not immediately be deleted from cache. That is up to the MOS Object Cleanup 
script, depending on how that is configured. NOTE: The Saved Item Cleanup script is 
automatically added to Job Schedule to be run every day at midnight. The time of day 
can be changed but the script cannot be deleted. 

●​ MOS Object Cleanup deletes all MOS Objects from the cache which have not been 
used for more than X number of days. X is specified in Admin Tools > MOS 
Configuration > MOS Object Lifetime and defaults to 90 days. 

●​ Cache Rollover - This job is for clients who wish to regularly delete all existing MOS 
Objects and restart the MOS ID numbering from scratch. If this is run, all existing MOS 
Objects in older stories and rundowns will be lost.  

●​ Asset Cleanup deletes Assets in a specific Context and subfolders or subfolder that 
are older than X days.  
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Create New Scheduled Job 

Selecting Create New Scheduled Job will 
open a new window that will allow the user 
to create/schedule a new job. Two Job 
Types, Saved Items Cleanup and LUCI 
Saved State Cleanup are created by default 
and cannot be created or deleted through 
this dialog.  

 
 
 

●​ Name – Enter the desired name for the job in the text box. 
●​ Job Type – Specify the action that is to be performed (Device Cleanup, Device 

Synchronize or MOS Object Cleanup, CAMIO Cleanup, Cache Rollover, Asset 
Cleanup ). 

●​ Days of the Week – Check the corresponding boxes in order to determine which days 
of the week the job is to be performed. 

●​ Time of Day – Specify the time (24 hour clock) on which the job is to be performed. 
●​ Run as soon as possible after scheduled start is missed  

o​ When checked, the job will run if the scheduled run time has passed that day. 
That could occur if the CAMIO was off during the scheduled run time, or if the 
job was newly created or enabled. 

o​ When not checked, the job will not run if the scheduled run time was missed 
that day. 

o​ This checkbox is checked by default when upgrading CAMIO or creating new 
jobs. This matches the operation of previous versions of CAMIO. 

Two additional settings apply only to the Cache Rollover job. 

●​ Context - Each cache rollover job is 
applied only on one Context, which needs to 
be defined. It is possible to create multiple 
Cache Rollover jobs if you wish to roll over 
more than one context. 

●​ Starting MOS ID specifies the 
numeric ID (i.e. 10000) to which CAMIO 
resets the counter for that context.  
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AXIS API 
Several CAMIO features are integrated tightly with the AXIS World Graphics hosted web 
services. This requires setting up the following configuration dialog. Contact Chyron support for 
assistance.  

 
 

Automation Transition Configuration 
This feature is used in special circumstances and does not apply to most installations. 
Automation Commands are text strings entered into a list using the Add New Transition button. 
These commands are sent to the news automation system as metadata in the MOS Object. 
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CAMIO Redundant Architectures 
 

CAMIO Cluster 
 

CAMIO Cluster provides users with a high availability asset management/MOS solution with 
fully redundant servers. Automatic and immediate failover is initiated in the event of a hardware 
failure. CAMIO Cluster is based on Windows Failover Cluster Server with SQL Server. It 
provides a high reliability RAID assembly for media storage and full hardware redundancy. 

PROS 

●​ Fully automated, very fast failover with no user intervention required. 
●​ Since primary and backup share the same RAID storage, the data is always up to date 

after a failover to the backup system. 

CONS 

●​ Entire system is co-located so this is not a true disaster recovery solution. 
●​ The system does not automatically make backups of media files. Users should make 

regular backups to recover from potential data corruption cases. 

Newsroom clients and playout systems do not require any changes during a failover. When 
properly configured with the user’s SMTP mail server, CAMIO Cluster can send an email 
notification of failure events. 

 

CAMIO Cluster Server or VM Specifications 

CAMIO Cluster Server requires two CAMIO physical or VM servers configured as a MSSQL 
SQL Cluster with a common virtual IP, and a shared NAS/SAN Storage. In the case of VMs, it is 
recommended that the CAMIO VM server pairs are installed on separate VM hosts for 
redundancy. 

CAMIO Cluster Server requires two CAMIO servers configured as a MSSQL SQL Cluster with a 
common virtual IP.    

Hardware Servers (x2) 

●​ 1 RU Chassis for hardware  
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●​ GigE port  
●​ Xeon 8 cores at 3.0 GHZ or above, with 32 GB RAM     
●​ Hard Drive C = 500 GB minimum (Internal system drive) 

OR VM Servers (x2) 

●​ VMWare preferred  
●​ GigE port  
●​ 8 Cores / 16 Threads @ 3.00 GHz or above, with 32 GB RAM     
●​ Hard Drive C = 200 GB minimum (Internal system drive) 
●​ It is recommended that CAMIO VM server pairs be installed on separate VM hosts for 

redundancy 

Operating System 

●​ Windows 2019 or 2022 Standard Edition  
●​ SQL Server 2019 Standard Edition  
●​ Configure Windows and SQL per Chyron commissioning instructions 

Shared Storage System  

●​ Suggested Storage: Dell ME5012 Storage Array 
●​ Dual Redundant 10G iSCSI required (2 per CAMIO server) 
●​ D, I, Q drives required, J is optional  
●​ Recommended drive config: 

○​ D = 500GB minimum (used for Database and CAMIO cache) 
○​ I = 3TB minimum (used for Media storage) 
○​ J = 3TB minimum (used for Hub Drive storage) 
○​ Q = 4GB (quorum drive needed for MS Windows Clustering only)   
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Redundancy Capabilities 

During Normal Operation 

 

 

Database, configuration and production files are stored on the Shared Storage that is reachable 
by the 2 CAMIO Nodes, however only the Primary CAMIO is active through its running 
Windows Services. 

 

After Failover due to an issue on the Primary CAMIO 
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If the Primary CAMIO Node is unreachable or having some failure at the infrastructure or 
application level, Microsoft Failover Cluster operates an automatic failover to the Backup 
CAMIO Node by assigning the Virtual IP Address and starting the SQL Server and CAMIO 
Services. 

 

Failback Procedure 
 

After recovery of CAMIO Node1, the Failback procedure, if configured, can be automated and 
run immediately or at specific time slots. However it has some risks and is preferred to be 
manual. To be executed during downtime hours to avoid impacting the production. To proceed, 

1.​ Connect to the CAMIO Node 2 (or Node 1 if correctly recovered) and launch the 
Failover Cluster Manager application 

2.​ From the left panel, go to Nodes and check that CAMIO Node 1 is up and healthy 

 

3.​ Once validated, go to Roles. There should be one unique Role, responsible for 
managing all clustered Resources: the Cluster virtual IP address and Network Name, 
the Storage partitions used by SQL Server and CAMIO, and also the SQL Server and 
CAMIO Services: 
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4.​ Right-click on the Role and select Move > Select Node… 
NOTE: do not run this operation on specific Resources of that Role (CAMIO 
Services, Storage File Server, SQL) as it may affect the whole system badly. 
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5.​ Then select the CAMIO Node 1 

 

 

CAMIO DR 
 

CAMIO DR is a new option for users who want to protect their data, but at an overall lower 
price. CAMIO DR is a warm standby backup system specifically designed for CAMIO  servers. 
It performs regularly scheduled backups of the primary CAMIO’s assets and databases. 

In the event there is a failure of the primary system, a manual procedure is used to fail-over 
operation to the CAMIO DR system, restoring the system to the state of the last backup. After 

 

106 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      



 

repairing or replacing the primary system, a manual procedure is used to fail-back operation to 
the CAMIO primary system. 

PROS 

●​ Lower cost, especially if a CAMIO is already deployed at the user’s site. 
●​ The backup system can be remotely located (assuming fast LAN connection) for 

disaster recovery scenarios. 
●​ System makes scheduled data backups, which could be restored in case of data 

corruption. 

CONS 

●​ Data is backed up on a schedule. After a failover, data will only be as current as the last 
backup. 

●​ The failover procedure is manual, hence no high availability. 
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Redundancy Capabilities 

During Normal Operation 

 

 

Database backups are periodically made on the Primary CAMIO Server and copied along with 
the content of the D, I and J Drives onto the Backup CAMIO DR Server, approximately every 5 
minutes. 

The Primary CAMIO Server’s NIC is configured with an extra Virtual IP Address that is used as 
CAMIO main endpoint. The CAMIO Windows Services on the Primary Server are running while 
stopped on the Backup Server. 
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After Failover due to an issue on the Primary CAMIO 

 

If the Primary CAMIO Server is unreachable or having some failure at the infrastructure or 
application level, an Administrator can run the Failover procedure from the Backup CAMIO DR 
using the DR Client application. 

It will perform the following actions sequentially: restore the database using the last copied 
backup file, configure the Virtual IP Address on the NIC and start the CAMIO Windows 
Services. 

 

Failover Procedure 

 

To execute the failover procedure in order to activate the Backup CAMIO DR Server, the 
Administrator should proceed with the following steps: 

6.​ Connect to the Backup CAMIO DR Server and launch the DR Client application: 
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7.​ The Machine Status tab should confirm that the Primary CAMIO Server is unreachable 
(Remote Machine Mode = Offline): 

 

 

8.​ From the Data Recovery Status tab, run the Failover Primary to Secondary without 
Final Backup option: 
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This will perform the following actions: 

●​ Checking again that the Primary CAMIO server is unreachable 
●​ Enabling the Virtual IP Address by adding it into the main NIC Settings 
●​ Restoring the last copied database backup 
●​ Starting the IIS Web Server 
●​ Starting all the CAMIO Services 

The following messages are displayed when complete: 
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Failback Procedure 

 

After recovery of the Primary CAMIO Server, the Administrator can run the Failback procedure 
as follow: 

1.​ Connect to the Backup CAMIO DR Server and launch the DR Client application: 

 

 

2.​ The Machine Status tab should confirm that the Primary CAMIO Server is back and 
inactive (Remote Machine Mode = Passive): 
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3.​ From the Data Recovery Status tab, run the Fail back from Secondary to Primary 
option: 
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This will perform the following actions: 

●​ Copying the last database backup and files to the Primary server 
●​ Stopping the IIS Web Server 
●​ Stopping all the CAMIO Services 
●​ Backuping the Database and copying it along with any newly updated file to the Primary 

server since the 1st copy 
●​ Disabling the Virtual IP Address 
●​ Enabling the Virtual IP Address on the Primary server by adding it into the main NIC 

Settings 
●​ Restoring the last copied database backup on the Primary server 
●​ Starting the IIS Web Server on the Primary server 
●​ Starting all the CAMIO Services on the Primary server 

The following messages are displayed when complete: 
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Appendix A: LUCI AutoFill 
What is LUCI AutoFill 
LUCI AutoFill is a feature in CAMIO and LUCI that enables quick update of template content 
with predetermined text and images.  

Data is formatted simply in a text file format and uploaded to the LUCI AutoFill Web Interface.  

When Lyric messages are created for CAMIO the designer will name text and image templates 
in a particular manner. Before uploading to CAMIO the designer will select which group of data 
in the LUCI AutoFill bank should be available in the current template for the producers and 
LUCI users to select. 

The LUCI user will select from a combo drop-down in the LUCI message editor that will 
automatically populate all related fields in the template with the associated content.  

Formatting the Data 
LUCI AutoFill uses a simple format. This can be created and saved in notepad where it is easy 
to see formatting. When creating the LUCI AutoFill Data File simply use forward slashes to 
separate the groups (or categories) of content.  
 

us/government/senators/{txt:Sen. Richard Blumenthal},{txt:(D) Connecticut},{img:Richard Blumenthal } 
us/government/senators/{txt:Sen. John McCain},{txt:(R) Arizona},{img:John McCain} 
us/government/representatives/{txt:Rep. Jo Bonner},{txt:(R) Alabama},{img:Jo Bonner} 
us/government/representatives/{txt:Rep. Bobby Bright},{txt:(D) Alabama},{img:Bobby Bright} 
sports/baseball/yankees/{txt:A.J. Burnett}{txt:34}{txt:6'4"},{txt:230},{txt:Jan 3, 1977},{img:A.J. Burnett} 
sports/baseball/yankees/{txt:Joba Chamberlain},{txt:62},{txt:6'2"},{txt:230},{txt:Sep 23, 1985},{img:Joba 

Chamberlain} 
sports/baseball/mets/{txt:Manny Acosta}{txt:36}{txt:6'4"}{txt:170}{txt:May 1, 1981},{img:Manny Acosta} 
sports/baseball/mets/{txt:Manuel Alvarez},{txt:5'11"},{txt:200},{txt:Dec 18, 1985},{img:Manuel Alvarez} 
sports/nba/teams/{txt:Atlanta},{txt:Hawks},{img:Atlanta Hawks Logo}, 
sports/nba/teams/{txt:Boston},{txt:Celtics},{img:Boston Celtics Logo}, 

 

The above data shows formatting for 5 different groups of data. 

●​ Senators - us/government/senators/ 
●​ Representatives - us/government/representatives/ 
●​ Yankees - sports/baseball/teams/yankees/ 
●​ Mets - sports/baseball/teams/mets/ 
●​ NBA Teams - sports/nba/teams/ 
 

The category of US has a subcategory of Government. Government has a subcategory of 
Senators and Representatives.  

The category of Sports has subcategories of Baseball and NBA. Baseball has a subcategory of 
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Yankees or Mets. NBA has a subcategory of Teams.  

The information that is input after the categories and the final forward slash, and in the curly 
braces, is the data that will populate the templates.  

●​ To format information that will simply populate a text field in the template start with 
“{txt:” then continue with the desired text information closing with a “}” (e.g. {txt:Sen. 
Richard Blumenthal}).  

●​ To format the reference to an image that should be used to populate a replaceable 
image in the template start with “{img:” then continue with the descriptive information 
that searched in the SUBJECT field of the CAMIO image assets and close with a “}” 
(e.g. {img:Richard Blumenthal}). 

 

The first field in curly brace will be the field offered in the combo drop-down in LUCI. All 
subsequent data in curly brace will automatically populate additional text and image input 
fields in LUCI. Therefore it is required to use a descriptive field, such as a name for the above 
Government example, as the first curly brace field. NOTE: This data can be created in a 
single or multiple files. “#” at the head of a row in the data file can be used for creator 
comments and will be commented out when the file is processed. 

Uploading and Managing LUCI AutoFill Data 
Once the text file is complete it should be saved locally so it can be uploaded to CAMIO’s LUCI 
Web Interface.  

To navigate to the LUCI Web Interface navigate to http://[CAMIONAME]/luciautofill/ where 
[CAMIONAME] is the name or IP address of the CAMIO Server.  

 

To upload a file: 
●​ Click the Upload button. 
●​ Browse to and select the stored .txt file. 
●​ It is essential to preview the data to ensure that it is in a valid format. Red notations 

indicate invalid formatting. 
●​ If the data is in a valid format click the Submit button.  

To delete a category: 
●​ Click the Delete button. 
●​ Select the data group to be deleted.  
●​ Click Delete Selected Group.  

To backup the current CAMIO categories: 
●​ Click the Download to File button. 
●​ Click Create Text File. 
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●​ A popup will display an offer to open or save the text file. Select either save or open. 
This backup will create a single file of all the uploaded categories.  
 

NOTE: To make changes to the data just modify/add/delete any line from the .txt file and 
re-upload. 

 

 

118 | CAMIO Administrator User Guide V5.5.5​ ​ ​ ​ ​ ​ ​

​ ​ ​      



 

Appendix B: MOS Object Metadata 
Format Strings 

Format String Data Element 

%ad The Duration for Automation (in timecode format) of a MOS 
Object 

%as The Start Time for Automation (in timecode format) of a 
MOS Object 

%ae The End Time for Automation (in timecode format) of a MOS 
Object 

%am Displays Automation Transition text string selected in LUCI.  

%cd Clip Duration of a clip object inserted into a Live Assist 
automation template. This is only displayed when used with 
a Live Assist automation template. 

%m The message number of the MOS Object 

%t The Filename of the Template which the MOS Object was 
created 

%s The exact Slug as entered by the user in the Slug input field 
in the LUCI 

%o The Object ID of the MOS Object 

%g The story Slug of the MOS Object 

%c Channel assignment of MOS Object 

%y Style assignment of PRIME MOS Object 

%u Pause Count (Lyric only) 

%% An explicit percent (%) character 

%0 The first text field's text data in the MOS Object content 

%1 The second text field's text data in the MOS Object content 

%2 The third text field's text data in the MOS Object content 
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%3 The fourth text field's text data in the MOS Object content 

%4 The fifth text field's text data in the MOS Object content 

%5 The sixth text field's text data in the MOS Object content 

%6 The seventh text field's text data in the MOS Object content 

%7 The eighth text field's text data in the MOS Object content 

%8 The ninth text field's text data in the MOS Object content 

%9 The tenth text field's text data in the MOS Object content 

%* Same as "%0 %1 %2 %3 %4 %5 %6 %7 %8 %9" 

%( ### %.) Repetitively emits the text content in between the opening 
and closing parentheses, once for each piece of text data in 
the MOS Object content, where the current iterative text 
data replaces the "%". For example, if the MOS Object's text 
data are as follows: 

Transit Strike 
Monday, November 24, 2003 
City Hall 

  
Then the resulting text is as follows: 

 ### Transit Strike ### Monday, November 24, 
2003 ### City Hall 

%. Used in conjunction with %(). See %( ### %.) above 
 
 

%(%.)(15) Similar to the above %(), but places a maximum iterative 
limit. In this example, the iterated text cannot exceed fifteen, 
even if there are sixteen or more pieces of text data in the 
MOS Object. 

%{relative 
xpath 

notation} 

The text content of the Running Order's MOS XML's 
<roCreate> tree's XML element specified by the relative 
xpath notation. The xpath notation is relative to the <item> 
element of the element tree. For example, to display the 
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Story Number associated with the MOS Object item, the 
xpath notation would be: ../storyNum 

 
Alternately, users can use a special XML formatting string designed to display all text, 
image and video fields. 
 
Syntax: %( | %.)<text><image><video><filename> 
 

●​ %( I %.) - This iterates through the following list of elements using pipe | as a separator. 
Any separator string can be used. 

●​ <text> - content of all replaceable text fields  
●​ <image> - title or filename of all replaceable image fields 
●​ <video> - title or filename of all replaceable video fields 
●​ <filename> - displays the filename of the image or video asset.  
●​ <title> - displays the title of the image or video asset 

 
‘Filename’ of the asset does not include the folder path, but does include the extension. 
‘Title’ of the asset is defined in Asset Manager and defaults to the filename without the 
extension.  
 
 
Examples: 
 
%(/%.)<text> - displays the test content of all replaceable text fields separated by a forward 
slash ‘/’ 
%(|%.)<text><images><title> - displays the text content of all replaceable text fields and the 
title of all replaceable image fields separated by a pipe ‘|’ 
%(#%.)<text><images><filename> - displays the text content of all replaceable text fields 
and the filename of all replaceable image fields separated by a hash sign ‘#’ 
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